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This manual describes the following vector network analyzer types:

● R&S® ZNB4, 2 test ports, order no. 1311.6010.22

● R&S® ZNB4, 4 test ports, order no. 1311.6010.24

● R&S® ZNB8, 2 test ports, order no. 1311.6010.42

● R&S® ZNB8, 4 test ports, order no. 1311.6010.44

● R&S® ZNB20, 2 test ports, order no. 1311.6010.62

● R&S® ZNB20, 4 test ports, order no. 1311.6010.64

● R&S® ZNB40, 2 test ports, order no. 1311.6010.72

● R&S® ZNBT8, 4 test ports (up to 24 ports optional), order no. 1318.7006.24

The software contained in this product makes use of several valuable open source software packages. For information, see the
"Open Source Acknowledgment" on the user documentation CD-ROM (included in delivery).
Rohde & Schwarz would like to thank the open source community for their valuable contribution to embedded computing.

© 2016 Rohde & Schwarz GmbH & Co. KG
Mühldorfstr. 15, 81671 München, Germany
Phone: +49 89 41 29 - 0
Fax: +49 89 41 29 12 164
Email: info@rohde-schwarz.com
Internet: www.rohde-schwarz.com
Subject to change – Data without tolerance limits is not binding.
R&S® is a registered trademark of Rohde & Schwarz GmbH & Co. KG.
Trade names are trademarks of the owners.

Throughout this guide R&S® is abbreviated as R&S.

mailto:info@rohde-schwarz.com
http://www.rohde-schwarz.com
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Basic Safety Instructions 

Always read through and comply with the following safety instructions! 

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety 

standards of our products up to date and to offer our customers the highest possible degree of safety. Our 

products and the auxiliary equipment they require are designed, built and tested in accordance with the 

safety standards that apply in each case. Compliance with these standards is continuously monitored by 

our quality assurance system. The product described here has been designed, built and tested in 

accordance with the EC Certificate of Conformity and has left the manufacturer’s plant in a condition fully 

complying with safety standards. To maintain this condition and to ensure safe operation, you must 

observe all instructions and warnings provided in this manual. If you have any questions regarding these 

safety instructions, the Rohde & Schwarz group of companies will be happy to answer them. 

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed 

for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must 

not be used in any way that may cause personal injury or property damage. You are responsible if the 

product is used for any purpose other than its designated purpose or in disregard of the manufacturer's 

instructions. The manufacturer shall assume no responsibility for such use of the product.  

The product is used for its designated purpose if it is used in accordance with its product documentation 

and within its performance limits (see data sheet, documentation, the following safety instructions). Using 

the product requires technical skills and, in some cases, a basic knowledge of English. It is therefore 

essential that only skilled and specialized staff or thoroughly trained personnel with the required skills be 

allowed to use the product. If personal safety gear is required for using Rohde & Schwarz products, this 

will be indicated at the appropriate place in the product documentation. Keep the basic safety instructions 

and the product documentation in a safe place and pass them on to the subsequent users. 

Observing the safety instructions will help prevent personal injury or damage of any kind caused by 

dangerous situations. Therefore, carefully read through and adhere to the following safety instructions 

before and when using the product. It is also absolutely essential to observe the additional safety 

instructions on personal safety, for example, that appear in relevant parts of the product documentation. In 

these safety instructions, the word "product" refers to all merchandise sold and distributed by the Rohde & 

Schwarz group of companies, including instruments, systems and all accessories. For product-specific 

information, see the data sheet and the product documentation. 

Safety labels on products 

The following safety labels are used on products to warn against risks and dangers. 

Symbol Meaning Symbol Meaning 

 

Notice, general danger location 

Observe product documentation 

    
ON/OFF  Power  

 

Caution when handling heavy equipment 

 

Standby indication 

 

Danger of electric shock  Direct current (DC) 
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Symbol Meaning Symbol Meaning 

 

 Caution ! Hot surface  Alternating current (AC) 

 

Protective conductor terminal  

To identify any terminal which is intended for 

connection to an external conductor for 

protection against electric shock  in case of a 

fault, or the terminal of a protective earth 

 Direct/alternating current (DC/AC) 

 

Earth (Ground) 

 
 

Class II Equipment 

to identify equipment  meeting the safety 

requirements specified for Class II equipment   

(device protected by double or reinforced 

insulation) 

 

Frame or chassis Ground terminal 

 

EU labeling for batteries and accumulators 

For additional information, see section "Waste 

disposal/Environmental protection", item 1. 

 

Be careful when handling electrostatic sensitive 

devices 

 

EU labeling for separate collection of electrical 

and electronic devices 

For additional information, see section "Waste 

disposal/Environmental protection", item 2. 

 

Warning! Laser radiation 

For additional information, see section 

"Operation", item 7. 

  

 

Signal words and their meaning 

The following signal words are used in the product documentation in order to warn the reader about risks 

and dangers. 

 

Indicates a hazardous situation which, if not avoided, will result in death or 

serious injury. 

 

Indicates a hazardous situation which, if not avoided, could result in death or 

serious injury. 

 

Indicates a hazardous situation which, if not avoided, could result in minor or 

moderate injury. 

 

Indicates information considered important, but not hazard-related, e.g. 

messages relating to property damage. 

In the product documentation, the word ATTENTION is used synonymously. 

These signal words are in accordance with the standard definition for civil applications in the European 

Economic Area. Definitions that deviate from the standard definition may also exist in other economic 

areas or military applications. It is therefore essential to make sure that the signal words described here 

are always used only in connection with the related product documentation and the related product. The 

use of signal words in connection with unrelated products or documentation can result in misinterpretation 

and in personal injury or material damage. 
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Operating states and operating positions 

The product may be operated only under the operating conditions and in the positions specified by the 

manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are 

not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local 

or national safety regulations and rules for the prevention of accidents must be observed in all work 

performed.  

1. Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:  

predefined operating position is always with the housing floor facing down, IP protection 2X, use only 

indoors, max. operating altitude 2000 m above sea level, max. transport altitude 4500 m above sea 

level. A tolerance of ±10 % shall apply to the nominal voltage and ±5 % to the nominal frequency, 

overvoltage category 2, pollution degree 2. 

2. Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability 

are unsuitable for this purpose. Always follow the manufacturer's installation instructions when 

installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation 

that is not carried out as described in the product documentation could result in personal injury or 

even death. 

3. Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient 

temperature must not exceed the maximum temperature specified in the product documentation or in 

the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or 

even death. 

Electrical safety 

If the information on electrical safety is not observed either at all or to the extent necessary, electric shock, 

fire and/or serious personal injury or death may occur.  

1. Prior to switching on the product, always ensure that the nominal voltage setting on the product 

matches the nominal voltage of the mains-supply network. If a different voltage is to be set, the power 

fuse of the product may have to be changed accordingly.  

2. In the case of products of safety class I with movable power cord and connector, operation is 

permitted only on sockets with a protective conductor contact and protective conductor. 

3. Intentionally breaking the protective conductor either in the feed line or in the product itself is not 

permitted. Doing so can result in the danger of an electric shock from the product. If extension cords 

or connector strips are implemented, they must be checked on a regular basis to ensure that they are 

safe to use. 

4. If there is no power switch for disconnecting the product from the mains, or if the power switch is not 

suitable for this purpose, use the plug of the connecting cable to disconnect the product from the 

mains. In such cases, always ensure that the power plug is easily reachable and accessible at all 

times. For example, if the power plug is the disconnecting device, the length of the connecting cable 

must not exceed 3 m. Functional or electronic switches are not suitable for providing disconnection 

from the AC supply network. If products without power switches are integrated into racks or systems, 

the disconnecting device must be provided at the system level. 

5. Never use the product if the power cable is damaged. Check the power cables on a regular basis to 

ensure that they are in proper operating condition. By taking appropriate safety measures and 

carefully laying the power cable, ensure that the cable cannot be damaged and that no one can be 

hurt by, for example, tripping over the cable or suffering an electric shock.  
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6. The product may be operated only from TN/TT supply networks fuse-protected with max. 16 A (higher 

fuse only after consulting with the Rohde & Schwarz group of companies). 

7. Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the 

socket provided for this purpose. Otherwise, sparks that result in fire and/or injuries may occur.  

8. Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric 

shocks. 

9. For measurements in circuits with voltages Vrms > 30 V, suitable measures (e.g. appropriate 

measuring equipment, fuse protection, current limiting, electrical separation, insulation) should be 

taken to avoid any hazards. 

10. Ensure that the connections with information technology equipment, e.g. PCs or other industrial 

computers, comply with the IEC 60950-1 / EN 60950-1 or IEC 61010-1 / EN 61010-1 standards that 

apply in each case. 

11. Unless expressly permitted, never remove the cover or any part of the housing while the product is in 

operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the 

product. 

12. If a product is to be permanently installed, the connection between the protective conductor terminal 

on site and the product's protective conductor must be made first before any other connection is 

made. The product may be installed and connected only by a licensed electrician. 

13. For permanently installed equipment without built-in fuses, circuit breakers or similar protective 

devices, the supply circuit must be fuse-protected in such a way that anyone who has access to the 

product, as well as the product itself, is adequately protected from injury or damage. 

14. Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of 

lightning) can reach the product. Otherwise, the person operating the product will be exposed to the 

danger of an electric shock. 

15. Any object that is not designed to be placed in the openings of the housing must not be used for this 

purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries. 

16. Unless specified otherwise, products are not liquid-proof (see also section "Operating states and 

operating positions", item 1). Therefore, the equipment must be protected against penetration by 

liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product 

itself may be damaged, which can also lead to personal injury. 

17. Never use the product under conditions in which condensation has formed or can form in or on the 

product, e.g. if the product has been moved from a cold to a warm environment. Penetration by water 

increases the risk of electric shock. 

18. Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network 

or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such 

as alcohol, acetone or diluents for cellulose lacquers. 

Operation 

1. Operating the products requires special training and intense concentration. Make sure that persons 

who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries 

or material damage may occur. It is the responsibility of the employer/operator to select suitable 

personnel for operating the products. 
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2. Before you move or transport the product, read and observe the section titled "Transport". 

3. As with all industrially manufactured goods, the use of substances that induce an allergic reaction 

(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a 

skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz 

product, consult a physician immediately to determine the cause and to prevent health problems or 

stress.  

4. Before you start processing the product mechanically and/or thermally, or before you take it apart, be 

sure to read and pay special attention to the section titled "Waste disposal/Environmental protection", 

item 1. 

5. Depending on the function, certain products such as RF radio equipment can produce an elevated 

level of electromagnetic radiation. Considering that unborn babies require increased protection, 

pregnant women must be protected by appropriate measures. Persons with pacemakers may also be 

exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces 

where there is a special risk of exposure to radiation and, if necessary, take measures to avert the 

potential danger. 

6. Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can 

cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and 

protective clothing must be worn. 

7. Laser products are given warning labels that are standardized according to their laser class. Lasers 

can cause biological harm due to the properties of their radiation and due to their extremely 

concentrated electromagnetic power. If a laser product (e.g. a CD/DVD drive) is integrated into a 

Rohde & Schwarz product, absolutely no other settings or functions may be used as described in the 

product documentation. The objective is to prevent personal injury (e.g. due to laser beams). 

8. EMC classes (in line with EN 55011/CISPR 11, and analogously with EN 55022/CISPR 22, 

EN 55032/CISPR 32) 

 Class A equipment:  

Equipment suitable for use in all environments except residential environments and environments 

that are directly connected to a low-voltage supply network that supplies residential buildings  

Note: Class A equipment is intended for use in an industrial environment. This equipment may 

cause radio disturbances in residential environments, due to possible conducted as well as 

radiated disturbances. In this case, the operator may be required to take appropriate measures to 

eliminate these disturbances. 

 Class B equipment: 

Equipment suitable for use in residential environments and environments that are directly 

connected to a low-voltage supply network that supplies residential buildings 

Repair and service 

1. The product may be opened only by authorized, specially trained personnel. Before any work is 

performed on the product or before the product is opened, it must be disconnected from the AC supply 

network. Otherwise, personnel will be exposed to the risk of an electric shock.  
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2. Adjustments, replacement of parts, maintenance and repair may be performed only by electrical 

experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant 

to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed 

after parts relevant to safety have been replaced (visual inspection, protective conductor test, 

insulation resistance measurement, leakage current measurement, functional test). This helps ensure 

the continued safety of the product.  

Batteries and rechargeable batteries/cells 

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the 

extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal 

injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g. 

lithium cells) must be handled in accordance with the EN 62133 standard. 

1. Cells must not be taken apart or crushed.  

2. Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided. 

Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth. 

3. Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a 

drawer where they can short-circuit each other, or where they can be short-circuited by other 

conductive materials. Cells and batteries must not be removed from their original packaging until they 

are ready to be used. 

4. Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted. 

5. If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If 

contact occurs, wash the affected area with plenty of water and seek medical aid. 

6. Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells) 

can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see 

parts list) in order to ensure the safety of the product.  

7. Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries 

and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the 

national regulations regarding waste disposal and recycling.  

Transport 

1. The product may be very heavy. Therefore, the product must be handled with care. In some cases, 

the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid 

back or other physical injuries.  

2. Handles on the products are designed exclusively to enable personnel to transport the product. It is 

therefore not permissible to use handles to fasten the product to or on transport equipment such as 

cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the 

means of transport or lifting. Observe the safety regulations of the manufacturer of the means of 

transport or lifting. Noncompliance can result in personal injury or material damage. 

3. If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely 

and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the 

product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the 

product in the vehicle to prevent injuries or other damage in the event of an accident.  



Instrucciones de seguridad elementales 

1171.0000.42 - 08 Page 7 

Waste disposal/Environmental protection 

1. Specially marked equipment has a battery or accumulator that must not be disposed of with unsorted 

municipal waste, but must be collected separately. It may only be disposed of at a suitable collection 

point or via a Rohde & Schwarz customer service center. 

2. Waste electrical and electronic equipment must not be disposed of with unsorted municipal waste, but 

must be collected separately. 

Rohde & Schwarz GmbH & Co. KG has developed a disposal concept and takes full responsibility for 

take-back obligations and disposal obligations for manufacturers within the EU. Contact your 

Rohde & Schwarz customer service center for environmentally responsible disposal of the product. 

3. If products or their components are mechanically and/or thermally processed in a manner that goes 

beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel) 

may be released. For this reason, the product may only be disassembled by specially trained 

personnel. Improper disassembly may be hazardous to your health. National waste disposal 

regulations must be observed.  

4. If handling the product releases hazardous substances or fuels that must be disposed of in a special 

way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the 

manufacturer of the hazardous substances or fuels and the applicable regional waste disposal 

regulations must be observed. Also observe the relevant safety instructions in the product 

documentation. The improper disposal of hazardous substances or fuels can cause health problems 

and lead to environmental damage. 

For additional information about environmental protection, visit the Rohde & Schwarz website. 

Instrucciones de seguridad elementales 

¡Es imprescindible leer y cumplir las siguientes instrucciones e informaciones de seguridad! 

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al día 

con los estándares de seguridad y de ofrecer a nuestros clientes el máximo grado de seguridad. Nuestros 

productos y todos los equipos adicionales son siempre fabricados y examinados según las normas de 

seguridad vigentes. Nuestro sistema de garantía de calidad controla constantemente que sean cumplidas 

estas normas. El presente producto ha sido fabricado y examinado según el certificado de conformidad 

de la UE y ha salido de nuestra planta en estado impecable según los estándares técnicos de seguridad. 

Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario deberá 

atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de empresas 

Rohde & Schwarz está siempre a su disposición en caso de que tengan preguntas referentes a estas 

informaciones de seguridad. 

Además queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto 

está destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente 

autorizado, para aplicaciones de campo y de ninguna manera deberá ser utilizado de modo que alguna 

persona/cosa pueda sufrir daño. El uso del producto fuera de sus fines definidos o sin tener en cuenta las 

instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna 

forma responsable de consecuencias a causa del mal uso del producto.  
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Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las 

indicaciones de la correspondiente documentación del producto y dentro del margen de rendimiento 

definido (ver hoja de datos, documentación, informaciones de seguridad que siguen). El uso del producto 

hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener 

en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en 

profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el 

uso de productos de Rohde & Schwarz, encontraría la información debida en la documentación del 

producto en el capítulo correspondiente. Guarde bien las informaciones de seguridad elementales, así 

como la documentación del producto, y entréguelas a usuarios posteriores. 

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o daños por 

peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las 

siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del 

producto. Deberán tenerse en cuenta todas las demás informaciones de seguridad, como p. ej. las 

referentes a la protección de personas, que encontrarán en el capítulo correspondiente de la 

documentación del producto y que también son de obligado cumplimiento. En las presentes 

informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas 

Rohde & Schwarz bajo la denominación de "producto", entre ellos también aparatos, instalaciones así 

como toda clase de accesorios. Los datos específicos del producto figuran en la hoja de datos y en la 

documentación del producto. 

Señalización de seguridad de los productos 

Las siguientes señales de seguridad se utilizan en los productos para advertir sobre riesgos y peligros. 

Símbolo Significado Símbolo Significado 

 

Aviso: punto de peligro general 

Observar la documentación del producto 

    
Tensión de alimentación de PUESTA EN 

MARCHA / PARADA 

 

Atención en el manejo de dispositivos de peso 

elevado  

Indicación de estado de espera (standby) 

 

Peligro de choque eléctrico  Corriente continua (DC) 

 

Advertencia: superficie caliente  Corriente alterna (AC) 

 

Conexión a conductor de protección  Corriente continua / Corriente alterna (DC/AC) 

 

Conexión a tierra 

 
El aparato está protegido en su totalidad por un 

aislamiento doble (reforzado) 

 

Conexión a masa 

 

Distintivo de la UE para baterías y 

acumuladores 

Más información en la sección 

"Eliminación/protección del medio ambiente", 

punto 1. 
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Símbolo Significado Símbolo Significado 

 

Aviso: Cuidado en el manejo de dispositivos 

sensibles a la electrostática (ESD) 

 

Distintivo de la UE para la eliminación por 

separado de dispositivos eléctricos y 

electrónicos 

Más información en la sección 

"Eliminación/protección del medio ambiente", 

punto 2. 

 

Advertencia: rayo láser 

Más información en la sección 

"Funcionamiento", punto 7. 

  

 

Palabras de señal y su significado 

En la documentación del producto se utilizan las siguientes palabras de señal con el fin de advertir contra 

riesgos y peligros. 

 

Indica una situación de peligro que, si no se evita, causa lesiones 

graves o incluso la muerte. 

 

Indica una situación de peligro que, si no se evita, puede causar 

lesiones graves o incluso la muerte. 

 

Indica una situación de peligro que, si no se evita, puede causar 

lesiones leves o moderadas. 

 

Indica información que se considera importante, pero no en relación 

con situaciones de peligro; p. ej., avisos sobre posibles daños 

materiales.  

En la documentación del producto se emplea de forma sinónima el 

término CUIDADO. 

 

Las palabras de señal corresponden a la definición habitual para aplicaciones civiles en el área 

económica europea. Pueden existir definiciones diferentes a esta definición en otras áreas económicas o 

en aplicaciones militares. Por eso se deberá tener en cuenta que las palabras de señal aquí descritas 

sean utilizadas siempre solamente en combinación con la correspondiente documentación del producto y 

solamente en combinación con el producto correspondiente. La utilización de las palabras de señal en 

combinación con productos o documentaciones que no les correspondan puede llevar a interpretaciones 

equivocadas y tener por consecuencia daños en personas u objetos. 

Estados operativos y posiciones de funcionamiento 

El producto solamente debe ser utilizado según lo indicado por el fabricante respecto a los estados 

operativos y posiciones de funcionamiento sin que se obstruya la ventilación. Si no se siguen las 

indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con 

posible consecuencia de muerte. En todos los trabajos deberán ser tenidas en cuenta las normas 

nacionales y locales de seguridad del trabajo y de prevención de accidentes.  
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1. Si no se convino de otra manera, es para los productos Rohde & Schwarz válido lo que sigue:  

como posición de funcionamiento se define por principio la posición con el suelo de la caja para 

abajo, modo de protección IP 2X, uso solamente en estancias interiores, utilización hasta 2000 m 

sobre el nivel del mar, transporte hasta 4500 m sobre el nivel del mar. Se aplicará una tolerancia de 

±10 % sobre el voltaje nominal y de ±5 % sobre la frecuencia nominal. Categoría de sobrecarga 

eléctrica 2, índice de suciedad 2.  

2. No sitúe el producto encima de superficies, vehículos, estantes o mesas, que por sus características 

de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalación del 

fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si 

se realiza la instalación de modo distinto al indicado en la documentación del producto, se pueden 

causar lesiones o, en determinadas circunstancias, incluso la muerte. 

3. No ponga el producto sobre aparatos que generen calor (p. ej. radiadores o calefactores). La 

temperatura ambiente no debe superar la temperatura máxima especificada en la documentación del 

producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse 

choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte. 

Seguridad eléctrica 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad 

eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia 

de muerte.  

1. Antes de la puesta en marcha del producto se deberá comprobar siempre que la tensión 

preseleccionada en el producto coincida con la de la red de alimentación eléctrica. Si es necesario 

modificar el ajuste de tensión, también se deberán cambiar en caso dado los fusibles 

correspondientes del producto.  

2. Los productos de la clase de protección I con alimentación móvil y enchufe individual solamente 

podrán enchufarse a tomas de corriente con contacto de seguridad y con conductor de protección 

conectado. 

3. Queda prohibida la interrupción intencionada del conductor de protección, tanto en la toma de 

corriente como en el mismo producto. La interrupción puede tener como consecuencia el riesgo de 

que el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de 

enchufe, deberá garantizarse la realización de un examen regular de los mismos en cuanto a su 

estado técnico de seguridad. 

4. Si el producto no está equipado con un interruptor para desconectarlo de la red, o bien si el 

interruptor existente no resulta apropiado para la desconexión de la red, el enchufe del cable de 

conexión se deberá considerar como un dispositivo de desconexión.  

El dispositivo de desconexión se debe poder alcanzar fácilmente y debe estar siempre bien accesible. 

Si, p. ej., el enchufe de conexión a la red es el dispositivo de desconexión, la longitud del cable de 

conexión no debe superar 3 m).  

Los interruptores selectores o electrónicos no son aptos para el corte de la red eléctrica. Si se 

integran productos sin interruptor en bastidores o instalaciones, se deberá colocar el interruptor en el 

nivel de la instalación. 

5. No utilice nunca el producto si está dañado el cable de conexión a red. Compruebe regularmente el 

correcto estado de los cables de conexión a red. Asegúrese, mediante las medidas de protección y 

de instalación adecuadas, de que el cable de conexión a red no pueda ser dañado o de que nadie 

pueda ser dañado por él, p. ej. al tropezar o por un choque eléctrico.  
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6. Solamente está permitido el funcionamiento en redes de alimentación TN/TT aseguradas con fusibles 

de 16 A como máximo (utilización de fusibles de mayor amperaje solo previa consulta con el grupo de 

empresas Rohde & Schwarz). 

7. Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por 

completo y fuertemente en la toma de corriente. La no observación de estas medidas puede provocar 

chispas, fuego y/o lesiones. 

8. No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto 

podría causar fuego o choques eléctricos. 

9. En las mediciones en circuitos de corriente con una tensión Ueff > 30 V se deberán tomar las medidas 

apropiadas para impedir cualquier peligro (p. ej. medios de medición adecuados, seguros, limitación 

de tensión, corte protector, aislamiento etc.). 

10. Para la conexión con dispositivos informáticos como un PC o un ordenador industrial, debe 

comprobarse que éstos cumplan los estándares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1 

válidos en cada caso. 

11. A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa 

mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y 

puede causar lesiones, fuego o daños en el producto. 

12. Si un producto se instala en un lugar fijo, se deberá primero conectar el conductor de protección fijo 

con el conductor de protección del producto antes de hacer cualquier otra conexión. La instalación y 

la conexión deberán ser efectuadas por un electricista especializado. 

13. En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automático ni otros 

mecanismos de seguridad similares, el circuito de alimentación debe estar protegido de modo que 

todas las personas que puedan acceder al producto, así como el producto mismo, estén a salvo de 

posibles daños. 

14. Todo producto debe estar protegido contra sobretensión (debida p. ej. a una caída del rayo) mediante 

los correspondientes sistemas de protección. Si no, el personal que lo utilice quedará expuesto al 

peligro de choque eléctrico. 

15. No debe introducirse en los orificios de la caja del aparato ningún objeto que no esté destinado a ello. 

Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o 

lesiones. 

16. Salvo indicación contraria, los productos no están impermeabilizados (ver también el capítulo 

"Estados operativos y posiciones de funcionamiento", punto 1). Por eso es necesario tomar las 

medidas necesarias para evitar la entrada de líquidos. En caso contrario, existe peligro de choque 

eléctrico para el usuario o de daños en el producto, que también pueden redundar en peligro para las 

personas. 

17. No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido 

condensaciones sobre el producto o en el interior de éste, como p. ej. al desplazarlo de un lugar frío a 

otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico. 

18. Antes de la limpieza, desconecte por completo el producto de la alimentación de tensión (p. ej. red de 

alimentación o batería). Realice la limpieza de los aparatos con un paño suave, que no se deshilache. 

No utilice bajo ningún concepto productos de limpieza químicos como alcohol, acetona o diluyentes 

para lacas nitrocelulósicas. 
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Funcionamiento 

1. El uso del producto requiere instrucciones especiales y una alta concentración durante el manejo. 

Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos 

necesarios en cuanto a aptitudes físicas, psíquicas y emocionales, ya que de otra manera no se 

pueden excluir lesiones o daños de objetos. El empresario u operador es responsable de seleccionar 

el personal usuario apto para el manejo del producto. 

2. Antes de desplazar o transportar el producto, lea y tenga en cuenta el capítulo "Transporte". 

3. Como con todo producto de fabricación industrial no puede quedar excluida en general la posibilidad 

de que se produzcan alergias provocadas por algunos materiales empleados ―los llamados 

alérgenos (p. ej. el níquel)―. Si durante el manejo de productos Rohde & Schwarz se producen 

reacciones alérgicas, como p. ej. irritaciones cutáneas, estornudos continuos, enrojecimiento de la 

conjuntiva o dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las 

causas y evitar cualquier molestia o daño a la salud.  

4. Antes de la manipulación mecánica y/o térmica o el desmontaje del producto, debe tenerse en cuenta 

imprescindiblemente el capítulo "Eliminación/protección del medio ambiente", punto 1. 

5. Ciertos productos, como p. ej. las instalaciones de radiocomunicación RF, pueden a causa de su 

función natural, emitir una radiación electromagnética aumentada. Deben tomarse todas las medidas 

necesarias para la protección de las mujeres embarazadas. También las personas con marcapasos 

pueden correr peligro a causa de la radiación electromagnética. El empresario/operador tiene la 

obligación de evaluar y señalizar las áreas de trabajo en las que exista un riesgo elevado de 

exposición a radiaciones. 

6. Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias tóxicas 

(gases, líquidos etc.) que pueden generar daños a la salud. Por eso, en caso de incendio deben 

usarse medidas adecuadas, como p. ej. máscaras antigás e indumentaria de protección. 

7. Los productos con láser están provistos de indicaciones de advertencia normalizadas en función de la 

clase de láser del que se trate. Los rayos láser pueden provocar daños de tipo biológico a causa de 

las propiedades de su radiación y debido a su concentración extrema de potencia electromagnética. 

En caso de que un producto Rohde & Schwarz contenga un producto láser (p. ej. un lector de 

CD/DVD), no debe usarse ninguna otra configuración o función aparte de las descritas en la 

documentación del producto, a fin de evitar lesiones (p. ej. debidas a irradiación láser). 

8. Clases de compatibilidad electromagnética (conforme a EN 55011 / CISPR 11; y en analogía con EN 

55022 / CISPR 22, EN 55032 / CISPR 32) 

 Aparato de clase A:  

Aparato adecuado para su uso en todos los entornos excepto en los residenciales y en aquellos 

conectados directamente a una red de distribución de baja tensión que suministra corriente a 

edificios residenciales.  

Nota: Los aparatos de clase A están destinados al uso en entornos industriales. Estos aparatos 

pueden causar perturbaciones radioeléctricas en entornos residenciales debido a posibles 

perturbaciones guiadas o radiadas. En este caso, se le podrá solicitar al operador que tome  las 

medidas adecuadas para eliminar estas perturbaciones. 

 Aparato de clase B: 

Aparato adecuado para su uso en entornos residenciales, así como en aquellos conectados 

directamente a una red de distribución de baja tensión que suministra corriente a edificios 

residenciales. 
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Reparación y mantenimiento 

1. El producto solamente debe ser abierto por personal especializado con autorización para ello. Antes 

de manipular el producto o abrirlo, es obligatorio desconectarlo de la tensión de alimentación, para 

evitar toda posibilidad de choque eléctrico.  

2. El ajuste, el cambio de partes, el mantenimiento y la reparación deberán ser efectuadas solamente 

por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los 

aspectos de seguridad (p. ej. el enchufe, los transformadores o los fusibles), solamente podrán ser 

sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad 

deberá realizarse un control de seguridad (control a primera vista, control del conductor de 

protección, medición de resistencia de aislamiento, medición de la corriente de fuga, control de 

funcionamiento). Con esto queda garantizada la seguridad del producto.  

Baterías y acumuladores o celdas 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterías y 

acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible 

consecuencia de muerte. El manejo de baterías y acumuladores con electrolitos alcalinos (p. ej. celdas de 

litio) debe seguir el estándar EN 62133. 

1. No deben desmontarse, abrirse ni triturarse las celdas.  

2. Las celdas o baterías no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz 

directa del sol. Las celdas y baterías deben mantenerse limpias y secas. Limpiar las conexiones 

sucias con un paño seco y limpio. 

3. Las celdas o baterías no deben cortocircuitarse. Es peligroso almacenar las celdas o baterías en 

estuches o cajones en cuyo interior puedan cortocircuitarse por contacto recíproco o por contacto con 

otros materiales conductores. No deben extraerse las celdas o baterías de sus embalajes originales 

hasta el momento en que vayan a utilizarse. 

4. Las celdas o baterías no deben someterse a impactos mecánicos fuertes indebidos. 

5. En caso de falta de estanqueidad de una celda, el líquido vertido no debe entrar en contacto con la 

piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un 

médico. 

6. En caso de cambio o recarga inadecuados, las celdas o baterías que contienen electrolitos alcalinos 

(p. ej. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o 

baterías solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de 

recambios).  

7. Las baterías y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterías o 

acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales. 

Respete en esta relación las normas nacionales de eliminación y reciclaje.  

Transporte 

1. El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con 

precaución y, si es necesario, usando un sistema de elevación adecuado (p. ej. una carretilla 

elevadora), a fin de evitar lesiones en la espalda u otros daños personales.  
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2. Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por 

personas. Por eso no está permitido utilizar las asas para la sujeción en o sobre medios de transporte 

como p. ej. grúas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los 

productos de manera segura a los medios de transporte o elevación. Para evitar daños personales o 

daños en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o 

elevación utilizado. 

3. Si se utiliza el producto dentro de un vehículo, recae de manera exclusiva en el conductor la 

responsabilidad de conducir el vehículo de manera segura y adecuada. El fabricante no asumirá 

ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un 

vehículo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehículo 

debidamente para evitar, en caso de un accidente, lesiones u otra clase de daños.  

Eliminación/protección del medio ambiente 

1. Los dispositivos marcados contienen una batería o un acumulador que no se debe desechar con los 

residuos domésticos sin clasificar, sino que debe ser recogido por separado. La eliminación se debe 

efectuar exclusivamente a través de un punto de recogida apropiado o del servicio de atención al 

cliente de Rohde & Schwarz. 

2. Los dispositivos eléctricos usados no se deben desechar con los residuos domésticos sin clasificar, 

sino que deben ser recogidos por separado. 

Rohde & Schwarz GmbH & Co.KG ha elaborado un concepto de eliminación de residuos y asume 

plenamente los deberes de recogida y eliminación para los fabricantes dentro de la UE. Para 

desechar el producto de manera respetuosa con el medio ambiente, diríjase a su servicio de atención 

al cliente de Rohde & Schwarz. 

3. Si se trabaja de manera mecánica y/o térmica cualquier producto o componente más allá del 

funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales 

pesados como p. ej. plomo, berilio o níquel). Por eso el producto solo debe ser desmontado por 

personal especializado con formación adecuada. Un desmontaje inadecuado puede ocasionar daños 

para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminación de 

residuos. 

4. En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que 

deban tratarse como residuos especiales (p. ej. refrigerantes o aceites de motor con intervalos de 

cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas 

sustancias y las normas regionales de eliminación de residuos. Tenga en cuenta también en caso 

necesario las indicaciones de seguridad especiales contenidas en la documentación del producto. La 

eliminación incorrecta de sustancias peligrosas o combustibles puede causar daños a la salud o 

daños al medio ambiente. 

Se puede encontrar más información sobre la protección del medio ambiente en la página web de 

Rohde & Schwarz. 
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Customer Support 
 

Technical support – where and when you need it 
For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support 
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a 
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz 
equipment. 
 

Up-to-date information and upgrades 
To keep your instrument up-to-date and to be informed about new application notes related to your 
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish. 
We will take care that you will get the right information. 
 

Europe, Africa, Middle East Phone +49 89 4129 12345 
customersupport@rohde-schwarz.com

North America Phone 1-888-TEST-RSA (1-888-837-8772) 
customer.support@rsa.rohde-schwarz.com

Latin America Phone +1-410-910-7988 
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone +65 65 13 04 88 
customersupport.asia@rohde-schwarz.com

China Phone +86-800-810-8228 /  
 +86-400-650-5896 
customersupport.china@rohde-schwarz.com

mailto:customersupport.asia@rohde-schwarz.com
mailto:customersupport.la@rohde-schwarz.com
mailto:customer.support@rsa.rohde-schwarz.com
mailto:customersupport@rohde-schwarz.com
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1 Documentation Map
The R&S ZNB/ZNBT documentation is delivered as a printed Getting Started guide
and a documentation CD-ROM providing the complete user documentation. In addi-
tion, a help system is embedded in the instrument.

Getting Started Guide

The Getting Started guide describes everything that is needed to put the instrument
into operation and helps you to get familiar with the R&S ZNB/ZNBT. It gives an intro-
duction to the instrument's operating concept and provides simple measurement exam-
ples. A printed Getting Started guide is delivered with each R&S ZNB/ZNBT.

User Manual

The User Manual complements the Getting Started guide, providing a detailed descrip-
tion of the instrument's capabilities, examples and reference information for manual
and remote control. The User Manual is available on the documentation CD-ROM; the
most recent version is available for download on the R&S ZNB/ZNBT product pages on
the R&S internet.

Help System

The help system is embedded in the instrument, offering quick, context-sensitive refer-
ence to the information needed for operation and programming. It comprises the com-
plete information of the Getting Started guide and the User Manual.

You can use the help also if you control the instrument from an external monitor. Fur-
thermore you can transfer the help to your PC and use it as a standalone help.

Documentation CD-ROM

The CD-ROM contains the complete user documentation for the R&S ZNB/ZNBT:
● the help system
● the Getting Started guide in printable form
● the User Manual in printable form
● brochures and data sheets in printable form
● the Service Manual in printable form
● links to various useful sites in the R&S Internet
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2 Putting the Analyzer into Operation
This section describes the basic steps to be taken when setting up the analyzer for the
first time.

Simple measurement examples are provided in Chapter 5, "Performing Measure-
ments", on page 59; for a description of the operating concept refer to Chapter 4,
"Operating the Instrument", on page 34. For all background and reference informa-
tion concerning manual and remote control of the instrument refer to your analyzer's
help system or user manual. A more detailed description of the hardware connectors
and interfaces is also part of the help system or user manual.

Risk of injury and instrument damage
The instrument must be used in an appropriate manner to prevent electric shock, fire,
personal injury, or damage.
● Do not open the instrument casing.
● Read and observe the "Basic Safety Instructions" at the beginning of this manual,

in addition to the safety instructions in the following sections. Notice that the data
sheet may specify additional operating conditions.

Risk of instrument damage during operation
An unsuitable operating site or test setup can damage the instrument and connected
devices. Ensure the following operating conditions before you switch on the instrument:
● All fan openings are unobstructed and the airflow perforations are unimpeded. The

minimum distance from the wall is 10 cm.
● The instrument is dry and shows no sign of condensation.
● The instrument is positioned as described in the following sections.
● The ambient temperature does not exceed the range specified in the data sheet.
● Signal levels at the input connectors are all within the specified ranges.
● Signal outputs are correctly connected and are not overloaded.

2.1 Unpacking and Checking the Instrument

Check the equipment for completeness using the delivery note and the accessory lists
for the various items. Should you notice any damage, immediately contact the carrier
who delivered the instrument.
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Packing material
Retain the original packing material. If the instrument needs to be transported or ship-
ped at a later date, you can use the material to protect the control elements and con-
nectors.

Risk of injury and damage during transportation and shipment
Insufficient protection against mechanical and electrostatic effects during transportation
and shipment can damage the instrument.
● Always make sure that sufficient mechanical and electrostatic protection is provi-

ded.
● When shipping an instrument, the original packaging should be used. If you do not

have the original packaging, use sufficient padding to prevent the instrument from
moving around inside the box. Pack the instrument in antistatic wrap to protect it
from electrostatic charging.

● Secure the instrument to prevent any movement and other mechanical effects dur-
ing transportation.

The carrying handles at the front of the casing are designed to lift or carry the instru-
ment. Do not apply an excessive external force to the handles.
As the R&S ZNBT is very heavy (over 35 kg fully equipped), it must always be carried
by two people using both carrying handles to avoid personal injury or damage to the
instrument.
Observe the information on transporting heavy instruments in the basic safety instruc-
tions included at the front of the printed manual and on the supplied CD ROM.

2.2 Positioning the Instrument

The network analyzer is designed for use under laboratory conditions, either on a
bench top or in a rack. Notice the general ambient conditions at the operating site
described under "Risk of instrument damage during operation" on page 8.

 

Positioning the Instrument
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Risk of electrostatic discharge
Electrostatic discharge (ESD) can cause damage to the electronic components of the
DUT and the analyzer. ESD is most likely to occur when you connect or disconnect a
device under test (DUT) or test fixture to the analyzer's test ports.
To prevent ESD, use a wrist strap and cord and connect yourself to the ground con-
nector on the rear panel of the R&S ZNB/ZNBT. For additional information refer to the
"Instructions for Electrostatic Discharge Protection" on the R&S ZNB/ZNBT documen-
tation CD-ROM.

2.3 Bench Top Operation

If the analyzer is operated on a bench top, the surface should be flat. The instrument
can be used in horizontal or vertical position, standing on its feet, or with the support
feet on the bottom expanded.

2.4 Operation in a 19" Rack

The R&S ZNB/ZNBT can be mounted in 19" racks using the adapter R&S ZZA-KN5
(order number 1175.3040.00). Proceed according to the mounting instructions supplied
with the rack adapter.

Risk of instrument damage in a rack
An insufficient airflow can cause the instrument to overheat, which may disturb the
operation and even cause damage.
Make sure that all fan openings are unobstructed, that the airflow perforations are
unimpeded, and that the minimum distance from the wall is 10 cm.

2.5 EMI Suppression

Electromagnetic Interference (EMI) may affect the measurement results.
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To suppress generated Electromagnetic Interference:
● Use suitable shielded cables of high quality. For example use double-shielded RF

and LAN cables.
● Always terminate open cable ends.
● Note the EMC classification in the data sheet.

2.6 Connecting the Analyzer to the AC Supply

The network analyzer is automatically adapted to the AC supply voltage, which must
be in the range of 100 V to 240 V at 50 Hz to 60 Hz. For the R&S ZNB 400 Hz is also
supported. The mains connector is located in the upper part of the rear panel (see
Chapter 3.3, "Rear Panel R&S ZNB", on page 29 or Chapter 3.4, "Rear Panel
R&S ZNBT", on page 31).

► Connect the network analyzer to the AC power source using the AC power cable
delivered with the instrument.

The maximum power consumption and the typical power consumption of the individual
analyzer models are listed in the data sheet.

The R&S ZNBT is protected by a fuse located below the AC power switch; see Chap-
ter 7.2, "Replacing Fuses", on page 71.

2.7 Starting the Analyzer and Shutting Down

The AC power switch is located in the upper part of the rear panel, together with the
mains connector and the fuse drawer (R&S ZNBT only; see Chapter 3.3, "Rear Panel
R&S ZNB", on page 29 or Chapter 3.4, "Rear Panel R&S ZNBT", on page 31).

To start the analyzer, proceed as follows:

1. Switch the AC power switch to position I (On).

After power-on, the analyzer automatically goes to standby or ready state, depend-
ing on the state of the standby toggle key at the front panel when the instrument
was switched off last time.

2. If necessary, press the standby toggle key on the front panel to switch the instru-
ment to ready state (R&S ZNB: green LED goes on; R&S ZNBT PWR LED turns
from amber to green).

The analyzer automatically performs a system check, boots the Windows® operat-
ing system and then starts the network analyzer (VNA) application. If the last ana-
lyzer session was terminated regularly, the VNA application uses the last recall set
with all instrument settings.
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To shut down the analyzer, proceed as follows:

1. Press the standby key.
This will cause the instrument to save the current recall set, close the VNA applica-
tion, shut down Windows®, and go to standby state. Of course you can also per-
form these steps manually, like in any Windows session.

2. If desired, set the AC power switch to position O (Off).

Risk of data loss
It is strongly recommended to switch the analyzer to standby state before disconnect-
ing it from the AC supply. If you set the power switch to 0 while the VNA application is
still running, you will lose the current settings. Moreover, loss of program data can not
be excluded if the application is terminated improperly.

The AC power switch can be permanently on. It is recommendable, however, to switch
it off if the instrument is not used for some time. When you switch the instrument back
on, be sure to comply with the extended warm–up phase specified in the data sheet.

2.8 Standby and Ready State

R&S ZNB: The standby toggle key is located in the bottom left corner of the front
panel. In standby state, the right, amber LED is on, in ready state, the left, green LED
is on.

R&S ZNBT: The standby toggle key is located in the bottom right corner of the front
panel. In standby state the PWR LED light is amber, in ready state it is green.

The standby power only supplies the power switch circuits and the optional oven
quartz (option R&S ZNB-B4/R&S ZNBT8-B4, "OCXO Frequency Reference"). In this
state it is safe to switch the AC power off and disconnect the instrument from the
power supply. In ready state all modules are power-supplied. When switched to ready
state, the analyzer initiates its startup procedure.

Observe the instructions for startup and shutdown in Chapter 2.7, "Starting the Ana-
lyzer and Shutting Down", on page 11.

2.9 Connecting External Accessories

The analyzer's standard PC interfaces (DVI-D, USB, LAN) can be used to connect a
variety of accessories:
● An external monitor expands/displays the Windows® desktop, which is, by default,

covered by the Vector Network Analyzer (VNA) application window in full-screen
mode.
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● External keyboard and mouse enable/simplify local control, in particular manual
(GUI) operation of the VNA application.

● A printer can be used for example to create hard copies of the measurement dia-
grams and traces from within the VNA application.

● A LAN connection can be established in order to access the hard disk or control
the analyzer from an external PC.

For the R&S ZNBT an external monitor and mouse are required for local operation.
The R&S ZNB can be fully controlled by tapping the touchscreen and front panel keys.

2.9.1 Connecting a Monitor

A standard monitor can be connected to the MONITOR (DVI-D) connector of the
R&S ZNB/ZNBT. No extra configuration is required.

Safety aspects
The monitor must be connected while the instrument is switched off (or in standby
mode). Otherwise correct operation can not be guaranteed.

Select "DISPLAY > View Bar > Hard Key Panel" from the Menu bar of the VNA appli-
cation to add the (virtual) "Hard Key Panel" to the analyzer screen.

2.9.2 Connecting a Keyboard

A keyboard can be connected to any of the USB connectors. After being auto-detected
by the operating system it can safely be disconnected and reconnected even during
measurements.

Keyboard configuration
The default input language is English – US. Select "Control Panel > Clock, Language,
and Region > Region and Language > Keyboards and Languages" from the Windows®

Start menu to configure the keyboard properties.

To access Windows®, press the Windows key on the front panel (R&S ZNB only) or on
the external keyboard.

2.9.3 Connecting a Mouse

A USB mouse can be connected to any of the USB connectors. After being auto-detec-
ted by the operating system it can safely be disconnected and reconnected even dur-
ing measurements.
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Mouse configuration
Select "Control Panel > Hardware and Sound > Devices and Printers > Mouse" from
the Windows® "Start" menu to configure the mouse properties.

To access Windows®, press the Windows key on the front panel (R&S ZNB only) or on
the external keyboard.

2.9.4 Connecting a Printer

A printer can be connected to any of the USB connectors. After successful installation
it can safely be disconnected and reconnected even during measurements. When
printing a copy (PRINT), the analyzer checks whether a printer is connected and
turned on and whether the appropriate printer driver is installed.

Printer driver installation
If required, printer driver installation is initiated using the operating system's "Add
Printer Wizard". The wizard is self-explanatory. A printer driver needs to be installed
only once, even though the printer may be temporarily removed from the analyzer.
A great variety of printer drivers is available on the analyzer. To obtain the complete
list, select "Control Panel > Hardware and Sound > Devices and Printers" from the
Windows® "Start" menu.

To access Windows®, press the Windows key on the front panel (R&S ZNB only) or on
the external keyboard.
You can load updated and improved driver versions or new drivers from an installation
disk, USB memory stick or another external storage medium. Alternatively, if the ana-
lyzer is integrated in a network, you can install driver data stored in a network directory.
In either case, use the "Add Printer" wizard to complete the installation.

Printer configuration
Use the "Page Setup" dialog or the "Start > Control Panel > Devices and Printers"
menu of Windows® to configure the printer properties and printing preferences.

2.9.5 Connecting a LAN Cable

A LAN cable can be connected to the LAN connector on the rear panel of the analyzer.
To establish a LAN connection proceed as follows:

1. Refer to section Chapter 2.12.1, "Assigning an IP Address", on page 17 and
learn how to avoid connection errors.

2. Connect a CAT6 or CAT7 RJ-45 (LAN, Ethernet) cable to the LAN port.

The LAN port of the analyzer is an auto-crossover Ethernet port. You can connect it to
a network that is equipped with Ethernet hardware (hub, switch, router), but you can
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also set up a direct connection to a computer or another test instrument. For both con-
nection types, you can use either crossover or straight through (patch) cables.

The IP address information is shown in the "SETUP > Remote Settings" softtool panel
and on the Mini display (R&S ZNBT only).

2.10 Minimizing the VNA application

With a minimized VNA application, you can access your analyzer's Windows® desktop
or run other applications.

To exit the default full-screen mode of the VNA application, deselect "Display > View
Bar > Title and Task Bar On". Then use the standard titlebar functions to minimize/
maximize/close the application window

To automatically start the VNA application with a minimized window

1. Right-click the VNA shortcut icon on the desktop and open the "Properties" dialog.

2. In the "Shortcut" tab, select "Run: Minimized"

After a software update the VNA application is started with a maximized window again.
Moreover, if a second VNA application is started after a first, minimized application,
this will cause the first application to appear in the foreground.

 

Minimizing the VNA application
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2.11 Changing the Screen Resolution (R&S ZNBT)

In case the R&S ZNBT fails to properly adjust the display resolution when an external
monitor is connected, proceed as follows:

1. Connect a USB keyboard and mouse as decribed in Chapter 2.9, "Connecting
External Accessories", on page 12.

2. Hold the Ctrl key and press Esc to show the task bar

3. Click the rectangular button at the very right of the task bar to show the Windows
desktop

4. Right click the Windows desktop and select "Screen resolution" from the context
menu

5. In the Windows Screen Resolution" management

a) Change the "Multiple displays" setting to "Show desktop only on 2"; apply and
confirm the modified settings ("Keep Changes")

b) Select Display 2 in the panel at the top
c) Change the dsiplay "Resolution" to the desired value by dragging the slider;

click "OK" and confirm the modified settings ("Keep Changes")

2.12 Remote Operation in a LAN

A LAN connection is used to integrate the analyzer into a home/company network. This
offers several applications, e.g.:
● Transfer data between a controller and the analyzer, e.g. in order run a remote

control program.
● Control the measurement from a remote computer using Remote Desktop or a sim-

ilar application.
● Use external network devices (e.g. printers).

Virus protection
An efficient virus protection is a prerequisite for secure operation in the network. Never
connect your analyzer to an unprotected network because this may cause damage to
the instrument software. For useful hints refer to the application note 1EF73_0E, which
is available at:
http://www.rohde-schwarz.de/de/service_support/downloads/application_notes?
type=20&downid=5699

The analyzer uses a user name and password as credentials for remote access; see
note on "User accounts and password protection" on page 69 for details. To protect
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the analyzer from unauthorized access, it is recommended to change the factory set-
ting.

LXI compliance
The analyzer complies with LXI class C. LXI gives you direct access to the LAN set-
tings described in the following sections; see "LXI Configuration" in your analyzer's
help system.

2.12.1 Assigning an IP Address

Depending on the network capacities, the TCP/IP address information for the analyzer
can be obtained in different ways.
● If the network supports dynamic TCP/IP configuration using the Dynamic Host

Configuration Protocol (DHCP), all address information can be assigned automati-
cally.

● If the network does not support DHCP, or if the analyzer is set to use alternate
TCP/IP configuration, the addresses must be set manually.

By default, the analyzer is configured to use dynamic TCP/IP configuration and obtain
all address information automatically. This means that it is safe to establish a physical
connection to the LAN without any previous analyzer configuration.

Manual TCP/IP configuration
If your network does not support DHCP, or if you choose to disable dynamic TCP/IP
configuration, you must assign valid address information before you connect the ana-
lyzer to the LAN. Contact your network administrator to obtain a valid IP address,
because connection errors can affect the entire network.

Administrator account
You need administrator rights to change the TCP/IP configuration. See note on "User
accounts and password protection" on page 69 for details.

The R&S ZNBT provides a miniature display in the upper right-hand corner of the front
panel indicating the current IP address of the instrument. See Chapter 3.2, "Front
Panel R&S ZNBT", on page 26.

To enter the TCP/IP address information manually

1. Obtain the IP address and subnet mask for the analyzer and the IP address for the
local default gateway from your network administrator. If necessary, also obtain the
name of your DNS domain and the IP addresses of the DNS and WINS servers on
your network.
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2. For the R&S ZNBT connect an external monitor, keyboard and mouse.

3. Press the Windows key in the SYSTEM keypad (R&S ZNB only) or on an external
keyboard to access Windows®.

4. Open the "Control Panel > Network and Internet > Network and Sharing Center >
Local Area Connection Status" dialog.

5. Select "Properties" and confirm the user account control message, depending on
your current user account.

● If your current account is an administrator account, select "Yes".
● If your account is an account with standard user rights, enter the password of

the administrator account and select "Yes".

Figure 2-1: Windows 7 User Account Control dialog

6. In the "Local Area Connection Properties" dialog opened, select "Internet Protocol
Version 4 (TCP/IPv4) > Properties" and enter the IP address information, e.g.:

Remote Operation in a LAN
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2.12.2 Remote Desktop Connection

Remote Desktop is a Windows® application which you can use to access and control
the analyzer from a remote computer through a LAN connection. While the measure-
ment is running, the analyzer screen contents are displayed on the remote computer,
and Remote Desktop provides access to all of the applications, files, and network
resources of the analyzer.

At the R&S ZNB/ZNBT by default remote connections are enabled using a local group
policy and remote access is granted to users instrument and administrator.

For detailed information about Remote Desktop and the connection refer to the Win-
dows® Help ("Windows Start Menu > Help and Support").

To establish a remote desktop connection, proceed as follows:

1. Connect remote Windows PC and VNA to the LAN and make sure an IP conncec-
tion can be established.

2. At the remote Windows PC select "Start > Programs > Accessories > Remote
Desktop Connection", enter the VNA's computer name or IP address and select
"Connect".

 

Remote Operation in a LAN
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2.12.3 Windows® Firewall Settings

A firewall protects an instrument by preventing unauthorized users from gaining access
to it through a network. In the default configuration of the R&S ZNB/ZNBT the firewall
is enabled. A remote desktop connection does not require any changes in the firewall
settings.

Administrator account
You need administrator rights to change the firewall settings. See note on "User
accounts and password protection" on page 69 above for details.

Some actions require a different firewall configuration, e.g.:
● To transfer data with other hosts in the LAN, you have to allow "File and Printer

Sharing".

To change the firewall settings proceed as follows:

1. Access the operating system by pressing the Windows® key on the external key-
board. Open the "Control Panel".

2. Select "System and Security > Windows Firewall".

● Select "Change Settings > Allow a program or feature through Windows Fire-
wall" to enable "File and Printer Sharing".

● Select "Turn Windows Firewall on or off" to enable or disable the firewall.

You must confirm a user account control message to allow the desired changes (see
Figure 2-1). For detailed information about the firewall refer to the Windows® Help.

Risks of changing the firewall settings
Disabling the firewall or allowing exceptions may make your instrument more vulnera-
ble to viruses and intruders. It is recommend to restore the default firewall configuration
after completing a task which requires modified settings.
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3 Instrument Tour
This chapter gives an overview of the control elements and connectors of the
R&S ZNB/ZNBT and gives all information that is necessary to put the instrument into
operation and connect external devices.

3.1 Front Panel R&S ZNB

The front panel of a R&S ZNB consists of the touchscreen with the diagrams and soft-
tool panels (left side), the hardkey area (right side) and the test port area below. Brief
explanations on the controls and connectors, the hardkey area and the rear panel can
be found on the next pages.

Two-port and four-port network analyzers
The figures and examples in this Getting Started guide show a two-port network ana-
lyzer. Everything described in this guide is also valid for four-port analyzers. The exten-
ded measurement functionality of the four-port instruments is described in the help sys-
tem and in the user manual.

Figure 3-1: R&S ZNB8 with two ports

3.1.1 Touchscreen

The analyzer is equipped with a 12.1'' XGA color touchscreen. The touchscreen pres-
ents all measurement results, mostly in the form of diagrams. Besides, all instrument
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functions can be accessed and operated by tapping the control elements on the touch-
screen. For an introduction to touchscreen operation, refer to Chapter 4.1, "Manual
Operation ", on page 34.

The following sections contain further useful information about manual control of the
instrument.
● Refer to the other sections in chapter Chapter 4, "Operating the Instrument",

on page 34 to learn how to handle traces and diagrams, and how to use menus,
keys and softtools.

● Refer to chapter "Concepts and Features" in the user manual or help system to
obtain information about the results in the diagram.

● Refer to section "Display Menu" in the user manual or help system to learn how to
customize the screen.

● Refer to the data sheet for the technical specifications of the display.

Screen saver
The screen saver function of the operating system can be used to switch off the display
if the analyzer receives no command for a selectable period of time. The display is
switched on again if any front panel key is pressed.
To enable the screen saver, access the Windows® operating system (e.g. by pressing
the Windows key in the SYSTEM keypad) and tap "Control Panel > Hardware and
Sound > Power Options > Edit Plan Settings > Turn off the display".

3.1.2 Setup Keys

The keys in the TRACE, CHANNEL, STIMULUS, and SYSTEM keypads call up groups
of related measurement settings. Each key corresponds to a softtool tab or a function
of the graphical user interface.

The TRACE keys give access to all trace settings, to the limit check settings, and to
the marker functions including marker search.
● The MEAS settings select the measured and displayed quantity.
● The FORMAT settings define how the measured data is presented in the diagram.
● The SCALE settings define how the active trace is displayed in the diagram

selected via FORMAT.
● The TRACE CONFIG settings store traces to the memory and perform mathemati-

cal operations on traces.
● The LINES settings define limits for the measurement results, visualize them in the

diagrams and activate/deactivate the limit check.
● The MARKER settings position markers on a trace, configure their properties and

select the format of the numerical readout. Markers can also be used to locate spe-
cific points on the trace, define the sweep range, and scale the diagram.

The CHANNEL keys give access to the hardware-related (channel) settings.
● The POWER BW AVG settings define the power of the internal signal source, the

IF bandwidth, and the sweep average.
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● The SWEEP settings define the scope of measurement, including the sweep type
and the number of measured sweeps.

● CAL provides all functions that are necessary to perform a system error correction
(calibration).

● CHANNEL CONFIG provides functions for channel management.
● The TRIGGER settings control the start of the measurement sequence.
● OFFSET EMBED provides a selection of length offset parameters to shift the mea-

surement plane.

The STIMULUS keys (START, STOP, CENTER, SPAN) define the sweep range,
depending on the sweep type.

 

The SYSTEM keys provide general system settings.
● FILE provides standard Windows® functions used to create, save, recall or print

recall sets, to copy the active screen and to shut down the application.
● The PRINT settings control an external printer that is used to print a hardcopy of

the current recall set.
● APPLIC gives access to external software tools.
● DISPLAY gives access to all display settings and to the functions which activate,

modify and arrange different diagrams.
● SETUP provides general system settings which are not restricted to a particular

recall set.
● The Windows® key opens the startup menu of the Windows® operating system

from where you can perform system configurations and call up additional software
utilities.

● HELP opens the context-sensitive help system of the analyzer.
● PRESET performs a preset of the instrument settings.

3.1.3 Data Entry Keys

The keys in the DATA ENTRY keypad are used to enter numbers, units, and charac-
ters. The data entry keys are only enabled while the cursor is placed on a data input
field in a dialog or in the Help navigation pane.
● The keys 0 to 9 enter the corresponding numbers.
● The function of the "." and "–" keys depends on the data type of the active input

field:
– In numeric input fields, the keys enter the decimal point and a negative sign for

the entered numeric value. Multiple entries have not effect.
– In character input fields, the keys enter a dot and a hyphen, respectively. Both

entries can be repeated as often as desired.
● The function of the four unit keys depends on the data type of the active input field;

see Chapter 4.5, "Entering Data", on page 51.
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– In numeric input fields, the G/n, M/μ, k/m or x1 keys multiply the entered value
with factors of 10(-)9, 10(-)6, 10(-)3 or 1 and add the appropriate physical unit. x1
is equivalent to ENTER and confirms the previous entry.

– In character input fields, the G/n, M/μ, k/m keys enter the letters G, M, K,
respectively. x1 is equivalent to ENTER and confirms the previous entry.

● ESC is used to:
– Cancel entries / close dialogs without activating the entries made (equivalent to

the "Close" button).
– Close the Help system.

● ENTER is used to:
– Activate the selected active control element, e.g. a button in a dialog or a link in

the "Contents" page of the Help system.
– Confirm selections and entries made and close dialogs (equivalent to the "OK"

button).
– Compress or expand menus or the Help table of contents

● BACKSPACE deletes the last character before the cursor position or the selected
character sequence or numeric value.

3.1.4 Rotary Knob

The rotary knob increases and decreases numerical values, scrolls within lists, acti-
vates controls and confirms entries. Turning or pressing the rotary knob is equivalent to
the action of the "Cursor Up" and "Cursor Down" navigation keys or of the ENTER key
in the DATA ENTRY keypad, respectively.

STEP SIZE opens an input box to select the steps (in units of the current physical
parameter) between two consecutive numerical values. The step size is also valid for
value changes using the "Cursor Up" and "Cursor Down" keys. See also Chapter 4.5.2,
"Using the Numeric Editor", on page 52.

3.1.5 Navigation Keys

The keys in the NAVIGATION keypad are used to navigate within the touchscreen and
the help system, to access and control active elements.

The "Cursor Up" and "Cursor Down" keys are used to:
● Scroll up and down in lists, e.g. among menu items, in a list of keywords, in the

Help table of contents, or in the Help index
● Navigate between table rows in diagrams. Press "OK" to toggle between navigation

mode and data entries.
● Increase and decrease numerical input values

"Cursor Up" (Down) become inactive as soon as the beginning of the list is reached.
"Cursor Up" (Down) is equivalent to a rotation of the rotary knob to the right (left).

The "Cursor Left" and "Cursor Right" keys are used to:
● Move the cursor to the left or right within input fields
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● Navigate between table columns in diagrams. Press "OK" to toggle between navi-
gation mode and data entries.

● Compress or expand menus or the Help table of contents
● Move the highlighted item in the menu bar of the active application

ENT OK is equivalent to the action of the ENTER key in the DATA ENTRY keypad.

UNDO reverses the last action, if possible. REDO reverses the action of the UNDO
button.

3.1.6 Standby Key

The standby toggle switch is located in the bottom left corner of the front panel.

The key serves two main purposes:
● Toggle between standby and ready state; see Chapter 2.8, "Standby and Ready

State", on page 12.
● Shut down the instrument; see Chapter 2.7, "Starting the Analyzer and Shutting

Down", on page 11.

3.1.7 Front Panel Connectors

The test ports and four USB connectors are located on the front panel of the R&S ZNB.

3.1.7.1 Test Ports

Numbered connectors:
● type N (7 mm, female) for R&S ZNB4 and R&S ZNB8
● PC (3.5 mm, male) for R&S ZNB20
● K (2.92 mm, male) for R&S ZNB40

The test ports serve as outputs for the RF stimulus signal and as inputs for the mea-
sured RF signals from the DUT (response signals).
● With a single test port, it is possible to generate a stimulus signal and measure the

response signal in reflection. For a measurement example refer to Chapter 5.2,
"Reflection S-Parameter Measurement", on page 67.

● With more than one test port it is possible to perform full two-port, 3-port, ... , or n-
port measurements; see Chapter 5.1, "Transmission S-Parameter Measurement",
on page 59.
In the standard R&S ZNB configuration, all test ports are supplied by a common
source. Four-port instruments are available with an optional second source.
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Maximum input levels
The maximum input levels at all test ports according to the front panel labeling or the
data sheet must not be exceeded.
In addition, the maximum input voltages of the other input connectors at the rear panel
must not be exceeded.

It is recommended to use a torque wrench when screwing RF cables on the test port
connectors.

3.1.7.2 USB Connectors

Four high speed Universal Serial Bus connectors of type A (master USB).

The USB ports can be used to connect
● external PC accessories such as mouse or other pointing devices, a keyboard,

printer or external storage device (USB stick, CD-ROM drive etc.)
● external measurement equipment such as a calibration unit, power meter, signal

generator or switch matrix

The length of passive connecting USB cables should not exceed 1 m. The maximum
current per USB port is 500 mA. See also Chapter 2.5, "EMI Suppression",
on page 10.

3.2 Front Panel R&S ZNBT

The largest part of R&S ZNBT front panel is reserved for the test ports, with an admin-
istrative area to the right. Brief explanations on the connectors and controls and the
rear panel can be found on the next pages.

 

 

Front Panel R&S ZNBT



Instrument TourR&S® ZNB/ZNBT

27Getting Started 1316.0062.02 ─ 20

Figure 3-2: Front view of R&S ZNBT (fully equipped with the maximum 24 ports)

Instrument damage caused by cleaning agents
Cleaning agents contain substances that may damage the instrument. For example,
cleaning agents that contain a solvent may damage the front panel labeling, plastic
parts, or the display.
Never use cleaning agents such as solvents (thinners, acetone, etc), acids, bases, or
other substances.
The outside of the instrument can be cleaned sufficiently using a soft, lint-free dust
cloth.

Mini display

A miniature display is provided in the upper right-hand corner of the front panel to pro-
vide the following instrument information:
● IP address
● Operational "Status" or "Error <error code>"

– "OK": no error
– Info: general errors (e.g. related to external devices or remote control)
– Warning: setting errors (e.g. generator power out of range)
– Error <error code>: severe errors (e.g. FW boot errors, HW errors)

● Control mode:
– "Local": manual interaction (e.g. via Remote Desktop)
– "Remote": remote control (using a script) via a LAN or GPIB connection

Front Panel R&S ZNBT
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LED controls

Above the standby toggle switch some LEDs indicate various status information:
● ERR: operation state; if an error occurs, the LED lights up red; for more information

on errors and troubleshooting see the R&S ZNB/ZNBT User Manual
● LAN: LAN error occurred
● PWR: power state (ready/standby); see Chapter 2.8, "Standby and Ready State",

on page 12

Standby key

The standby key is located at the lower right-hand corner of the front panel. It serves
two main purposes:
● Toggle between standby and ready state; see Chapter 2.8, "Standby and Ready

State", on page 12.
● Shut down the instrument; see Chapter 2.7, "Starting the Analyzer and Shutting

Down", on page 11.

3.2.1 Front Panel Connectors

The test ports and two USB connectors are located on the front panel of the analyzer.

3.2.1.1 Test Ports

Numbered type N female connectors. Depending on the equipped options there are 4,
8, 12, 16, 20 or 24 test ports.

The test ports serve as outputs for the RF stimulus signal and as inputs for the mea-
sured RF signals from the DUT (response signals).
● With a single test port, it is possible to generate a stimulus signal and measure the

response signal in reflection. For a measurement example refer to Chapter 5.2,
"Reflection S-Parameter Measurement", on page 67.

● With more than one test port it is possible to perform full two-port, 3-port, ... , or n-
port measurements; see Chapter 5.1, "Transmission S-Parameter Measurement",
on page 59.

Maximum input levels
The maximum input levels at all test ports according to the front panel labeling or the
data sheet must not be exceeded.
In addition, the maximum input voltages of the other input connectors at the rear panel
must not be exceeded.
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It is recommended that you use a torque wrench when screwing RF cables on the test
port connectors.

Connector usage

Two LEDs next to each test port indicate the connector usage:
●  on: connector is used as a source port
●  on: connector is used as a receive port
● both LEDs on: connector is used as a bidirectional (source and receive) port

3.2.1.2 USB Connectors

Two high speed Universal Serial Bus connectors of type A (master USB) are provided
on the front panel. They can be used to connect
● external PC accessories such as mouse or other pointing devices, a keyboard,

printer or external storage device (USB stick, CD-ROM drive etc.)
● external measurement equipment such as a calibration unit, power meter, signal

generator or switch matrix

The length of passive connecting USB cables should not exceed 1 m. The maximum
current per USB port is 500 mA. See also Chapter 2.5, "EMI Suppression",
on page 10.

3.3 Rear Panel R&S ZNB

This section gives an overview of the rear panel controls and connectors of the net-
work analyzer. 
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Figure 3-3: R&S ZNB rear view

Table 3-1: Rear panel connectors available on all instruments

Index Label Description

1 (Power
I/O)

Power on / off switch, see Chapter 2.7, "Starting the Analyzer and Shutting Down",
on page 11

2 LAN RJ-45 connector to integrate the instrument to a Local Area Network, primarily for
remote control purposes; see Chapter 2.12.1, "Assigning an IP Address",
on page 17.

3 USB The two additional USB connectors are equivalent to the USB connectors on the
front panel; see Chapter 3.1.7.2, "USB Connectors", on page 26.

4 MONITOR
(DVI-D)

External monitor connector; see Chapter 2.9.1, "Connecting a Monitor", on page 13.

5 (User
port)

25-pin D-Sub connector used as an input and output for low-voltage (3.3 V) TTL
control signals

6 EXT TRIG
IN / EXT
TRIG
OUT

Two BNC connectors for 5 V TTL external trigger signals

7 REF OUT BNC output for the internal reference frequency of the R&S ZNB. Use this connector
to synchronize other instruments to the analyzer.

8 REF IN BNC input for an external reference frequency. Use this connector to synchronize
the R&S ZNB to another device.

Rear Panel R&S ZNB
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Index Label Description

9 (System
drive)

Contains the removable system hard disk of the R&S ZNB, containing all software
(including the operating system and the VNA application) and data. No other hard
disk is built in. Do not remove the disk during operation.

Option R&S ZNB-B19 Var. 02 provides an additional removable HD (including firm-
ware) for instruments with controller LPW10 (32 bit).

Option R&S ZNB-B19 Var. 07 provides an additional removable HD (including firm-
ware) for instruments with controller LPW11 (64 bit).

10 (Ground
connector)

The ground connector provides the ground of the analyzer's supply voltage. Use this
connector for ESD protection; see "Risk of electrostatic discharge" on page 10.

Table 3-2: Optional rear panel connectors

Index Label Description

11 Bias Tees

or

RFFE -
GPIO
Interface

This slot can be equipped with one of the following options:
● R&S ZNB-B1, "Bias Tees", providing two or four additional BNC inputs labeled

BIAS 1 ... 4 (for two-port or four-port analyzers). The inputs can be used to
apply an external DC voltage (bias) to the test ports. For fuse replacement refer
to Chapter 7.2, "Replacing Fuses", on page 71.

● R&S ZN-B15 "RFFE - GPIO Interface", providing 2 independent RF Front-End
(RFFE) interfaces according to the MIPI® Alliance "System Power Management
Interface Specification" and 10 General Purpose Input/Output (GPIO) pins on a
single 25 pin female connector

12 Device
Control

Option R&S ZNB-B12 "Device Control" provides a PCIe and a Direct Control con-
nector.

13 Handler
I/O

Option R&S ZN-B14, Handler I/O (Universal Interface), providing a Centronics 36
input/output connector.

14 GPIB Option R&S ZNB-B10 provides a GPIB bus connector according to standard IEEE
488 / IEC 625.

15 DC INPUT Option R&S ZNB-B81"DC Inputs" provides four BNC inputs for DC measurements
(adjustable to different voltage ranges).

Input levels, EMC
The maximum input levels and voltages of the input connectors at the front and rear
panel must not be exceeded.
Use double shielded cables at the BNC rear panel connectors (EXT. TRIGGER OUT,
EXT TRIGGER IN, REF OUT, REF IN) and match signals with 50 Ω in order to comply
with EMC directives! See also Chapter 2.5, "EMI Suppression", on page 10.

3.4 Rear Panel R&S ZNBT

This section gives an overview of the rear panel controls and connectors of the
R&S ZNBT. 
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Figure 3-4: R&S ZNBT rear view

Table 3-3: Rear panel connectors available on all instruments

Index Label Description

1 (Power
I/O)

Power on/off switch, see Chapter 2.7, "Starting the Analyzer and Shutting Down",
on page 11

2 (Fuse
holder)

Fuse holder, see Chapter 7.2, "Replacing Fuses", on page 71

3 LAN RJ-45 connector to integrate the instrument to a Local Area Network, primarily for
remote control purposes; see Chapter 2.12.1, "Assigning an IP Address",
on page 17.

4 USB The two additional USB connectors are equivalent to the USB connectors on the
front panel; see Chapter 3.2.1.2, "USB Connectors", on page 29.

5 MONITOR
(DVI-D)

External monitor connector; see Chapter 2.9.1, "Connecting a Monitor", on page 13.

6 (User
port)

25-pin D-Sub connector used as an input and output for low-voltage (3.3 V) TTL
control signals

7 EXT TRIG
IN / EXT
TRIG
OUT

Two BNC connectors for 5 V TTL external trigger signals

8 REF OUT BNC output for the internal reference frequency of the R&S ZNBT. Use this connec-
tor to synchronize other instruments to the analyzer.

9 REF IN BNC input for an external reference frequency. Use this connector to synchronize
the R&S ZNBT to another device.

10 (System
drive)

Contains the removable system hard disk of the R&S ZNBT, containing all software
(including the operating system and the VNA application) and data. No other hard
disk is built in. Do not remove the disk during operation.
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Index Label Description

11 (Ground
connector)

The ground connector provides the ground of the analyzer's supply voltage. Use this
connector for ESD protection; see "Risk of electrostatic discharge" on page 10.

12 Digital I/O Used to connect an external Handler I/O (option R&S ZNBT-Z14), providing a Cen-
tronics 36 input/output connector.

Table 3-4: Optional rear panel connectors

Index Label Description

13 DC INPUT Option R&S ZNBT8-B81"DC Inputs" provides four BNC inputs for DC measurements
(adjustable to different voltage ranges).

14 Device
Control

This slot can be equipped with option R&S ZNBT8 -B12, providing a PCIe and a
Direct Control connector.

15 GPIB Option R&S ZNBT8-B10 provides a GPIB bus connector according to standard IEEE
488 / IEC 625.

Input levels, EMC
The maximum input levels and voltages of the input connectors at the front and rear
panel must not be exceeded.
Use double shielded cables at the BNC rear panel connectors (EXT. TRIGGER OUT,
EXT TRIGGER IN, REF OUT, REF IN) and match signals with 50 Ω in order to comply
with EMC directives! See also Chapter 2.5, "EMI Suppression", on page 10.
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4 Operating the Instrument
The following sections describe how to solve basic tasks that you will frequently
encounter when working with the instrument. In particular you can learn how to access
instrument functions and control dialogs without a mouse and/or keyboard.

Manual and remote control of the instrument

In contrast to the R&S ZNB, the R&S ZNBT is primarily intended to be remote-control-
led via the GPIB or LAN interface (see chapter 'Remote Control' in the user manual).
However, all instruments can be controlled manually, either using touchscreen and
frontpanel keys (R&S ZNB only), an external monitor in combination with a mouse (see
also Chapter 2.9, "Connecting External Accessories", on page 12) or via Remote
Desktop (see also Chapter 2.12, "Remote Operation in a LAN", on page 16).

Manual and remote control of the R&S ZNB/ZNBT are described in separate chapters
of the user manual. Background information is provided in the reference chapter for
manual control, together with the dialogs that may be displayed on an external monitor.
To avoid redundancy, the reference chapter for remote control focusses on program
syntax and parameter ranges but contains only a short description of the command
functions.

Manual operation is particularly useful for getting to know the instrument and for trou-
ble shooting. The following sections describe how to access the instrument functions
and control dialogs at the graphical user interface.

4.1 Manual Operation

The analyzer functions are arranged in tabbed softtool panels and dialogs. The keys
on the front panel (R&S ZNB only) or the on-screen "Hard Key Panel" open the most
frequently used panels. This provides quick access to the instrument settings, avoiding
complicated menu structures and long operating sequences. The control elements in
the softtool panels can be accessed in different alternative ways.
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Customizing the screen
The contents of the screen and the size and position of many display and control ele-
ments are not fixed. You can display or hide most elements. You can also drag and
drop traces, info fields, and even the softtool panel to your preferred position; see
Chapter 4.4.4, "Using Drag and Drop", on page 50.
For example, you can show/hide the on-screen Hard Key Panel by selecting/deselect-
ing "Display > View Bar > Hard Key Panel On" in the main menu.

The following table shows possible touchscreen operations (R&S ZNB only) with the
corresponding mouse operations.

Touchscreen Mouse Typical task

Tap control element for a short time Click control element (left mouse button) Select button or softtool tab

Tap for an extended time (tap and hold) Click (right button) Open context menu

Tap twice (double-tap) Double-click (left button) Open on-screen keyboard

Using (Virtual) Hard Keys

To access an instrument function

1. Press a (virtual) key, e.g. the MEAS key in the TRACE panel.

The corresponding softtool panel expands at the current docking position.

Manual Operation
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2. Activate the desired softtool tab, e.g. "Z←Sij".

3. Select a control element, e.g. "Z←S11".

The diagram immediately shows the result of your setting. In the present example,
the active trace shows the converted impedance parameter Z11.
A control element with three dots (e.g. "SYSTEM > SETUP > System Config...")
opens a dialog, containing a group of related settings, a wizard or additional infor-
mation.

Manual Operation
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Using the menu bar

The menu bar at the bottom of the application screen provides an alternative access to
all instrument functions. To repeat the "Z←S11" setting described above,

► Select "Trace > Meas > Z←Sij > Z←S11".

The diagram immediately shows the result of your setting. At the same time, the
related softtool tab is opened.

Using context menus

Context menus are another alternative for quick access to instrument settings. To
repeat the "Z←S11" setting described above,

1. Touch and hold (R&S ZNB only) or right-click the measured quantity section in the
trace list for a couple of seconds until the context menu appears.

Manual Operation
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2. Select "S-Parameter" to open the "Meas > S-Params" softtool tab.

3. Select "Z←Sij > Z←S11".

Manual Operation
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4.2 Control Elements of the Screen

The main window of the analyzer provides all control elements for the measurements
and contains the diagrams for the results. There are several alternative ways for
accessing an instrument function:
● Using the icons in the toolbar above the diagram area (for frequent actions)
● Using the control elements of the softtool panel (recommended, provides all set-

tings)
● Using the menus and submenus of the menu bar (alternative to the previous

method)
● Using the hardkey panel (preselection of the most important softtool panels)
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These methods are described in more detail in the following sections.

4.2.1 Title Bar

The main application window of the vector network analyzer application provides a title
bar, in analogy to every Windows® application. The title bar contains the name of the
application and the standard minimize, maximize, and close buttons. The appearance
depends on the "Control Panel" settings of the operating system.

You can display or hide the title bar using "SYSTEM > DISPLAY > View Bar" or
"APPLIC > External Tools". The title bar is displayed together with the taskbar across
the bottom of the screen which you can use to change between the VNA application
and external tools.
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4.2.2 Toolbar

The toolbar above the diagram area contains the most frequently used control ele-
ments of the user interface. All controls are also accessible from the R&S ZNB/ZNBT's
softtool panels.

The toolbar is divided into five icon groups, separated by vertical lines.
● The leftmost group comprises recall set actions ("SYSTEM > FILE > Recall Sets"):

add a new recall set ("New..."), open a recall set file ("Open Recall..."), save the
active recall set to a file ("Save...")

● The second group comprises the undo and redo actions that are also accessible
via the SYSTEM > UNDO and SYSTEM > REDO front panel keys.

● The icons in the middle group control the graphical zoom function ("TRACE >
SCALE > Zoom"): "Zoom Reset", "Zoom Select", and "Overview Select".

● The icons in the fourth group allow to add a new trace and (possibly) a new dia-
gram ("TRACE > TRACE CONFIG > Trace"), add a marker ("TRACE > Marker >
Markers"), and delete a marker, trace, or diagram.

● The icon in the rightmost group allows to restart the sweep ("CHANNEL > SWEEP
> Sweep Control > Restart Sweep")

You can hide the toolbar using "SYSTEM > DISPLAY > View Bar".

4.2.3 Softtool Panel

Softtool panels display groups of related settings. They can be opened via keys on the
front panel (R&S ZNB only) or the on-screen "Hard Key" panel, or via menu bar and
context menu items. Selecting a control element in the softtool panels activates a set-
ting. You can also enter values and open dialogs with extended settings.

A softtool panel consists of a title (e.g. "Display") with a close/re-open icon and the
control element area below. The title remains displayed when the softtoool panel is
closed, which allows you to re-open closed softtools at any time. Most softtool panels
are subdivided into different tabs (e.g. "Diagram", "Split", "Config", "View Bar").
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Softtool panels may contain different types of control elements:
● A button with a double arrow (e.g. "Color Scheme" in the example above) opens a

list of alternative settings.
● A button with three dots (e.g. "User Define..." in the example above) opens a dialog

which provides several related settings.
● A button with a checkmark (e.g. "Frequency Info" in the example above) enables or

disables.
● A button with a light background (e.g. "Font Size" in the example above) is an input

fields for numbers or characters.
● A labeled button with no additional symbols directly initiates an action.

4.2.4 Menu Bar

All analyzer functions are arranged in drop-down menus. The menu bar is located
across the bottom of the diagram:

As in any Windows® application, menus can be controlled with the touchscreen
(R&S ZNB only) or a mouse. A short tap (left mouse click) expands a menu or sub-
menu. If a menu command has no submenu assigned, a short tap (left mouse click)
opens a dialog or directly activates the menu command. When a (sub)menu is
selected, the R&S ZNB/ZNBT displays the corresponding softtool panel.

Overview of menu functions
● The "File" menu provides standard Windows® functions that can be used to create,

save, recall or print recall sets, to copy the current screen or to shut down the
application.
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● The "Trace" menu provides all trace settings, the limit check settings, and the
marker functions including marker search.

● The "Channel" menu provides all channel settings and activates, modifies or stores
different channels.

● The "Display" menu provides all display settings and the functions for activating,
modifying and arranging different diagrams.

● The "Applications" menu gives access to applications and tools that extend the
functionality of the analyzer firmware.

● The "System" menu provides functions that can be used to return to a defined
instrument state, reverse operations, access service functions and define various
system-related settings.

● The "Help" menu provides assistance with the network analyzer and its operation.

You can hide the menu bar using "SYSTEM > DISPLAY > View Bar".

4.2.5 Menu Structure

All menus show an analogous structure.

● A menu command with a right arrow expands a submenu with further related set-
tings.
Example: "Marker" expands a submenu with marker-related properties.

● A menu command with three dots appended calls up a dialog providing several
related settings.
Example: "Search Range" opens a dialog to define the search range for the
marker search.

● A menu command with no arrow or dots initiates an immediate action.
Example: "Max" sets the active marker to the maximum of the active trace.
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4.2.6 Hardkey Emulation

The keys of the hardkey panel (see "SYSTEM > DISPLAY > View Bar") open a particu-
lar tab of the softtool panel providing related control elements.

The keys in the TRACE, CHANNEL, STIMULUS, and SYSTEM keypads call up groups
of related measurement settings. Each key corresponds to a softtool tab or a function
of the graphical user interface.

The TRACE keys give access to all trace settings, to the limit check settings, and to
the marker functions including marker search.
● The MEAS settings select the measured and displayed quantity.
● The FORMAT settings define how the measured data is presented in the diagram.
● The SCALE settings define how the active trace is displayed in the diagram

selected via FORMAT.
● The TRACE CONFIG settings store traces to the memory and perform mathemati-

cal operations on traces.
● The LINES settings define limits for the measurement results, visualize them in the

diagrams and activate/deactivate the limit check.
● The MARKER settings position markers on a trace, configure their properties and

select the format of the numerical readout. Markers can also be used to locate spe-
cific points on the trace, define the sweep range, and scale the diagram.

The CHANNEL keys give access to the hardware-related (channel) settings.
● The POWER BW AVG settings define the power of the internal signal source, the

IF bandwidth, and the sweep average.
● The SWEEP settings define the scope of measurement, including the sweep type

and the number of measured sweeps.
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● CAL provides all functions that are necessary to perform a system error correction
(calibration).

● CHANNEL CONFIG provides functions for channel management.
● The TRIGGER settings control the start of the measurement sequence.
● OFFSET EMBED provides a selection of length offset parameters to shift the mea-

surement plane.

The STIMULUS keys (START, STOP, CENTER, SPAN) define the sweep range,
depending on the sweep type.

 

The SYSTEM keys provide general system settings.
● FILE provides standard Windows® functions used to create, save, recall or print

recall sets, to copy the active screen and to shut down the application.
● The PRINT settings control an external printer that is used to print a hardcopy of

the current recall set.
● APPLIC gives access to external software tools.
● DISPLAY gives access to all display settings and to the functions which activate,

modify and arrange different diagrams.
● SETUP provides general system settings which are not restricted to a particular

recall set.
● The Windows® key opens the startup menu of the Windows® operating system

from where you can perform system configurations and call up additional software
utilities.

● HELP opens the context-sensitive help system of the analyzer.
● PRESET performs a preset of the instrument settings.

4.2.7 Status Bar

The status bar shows
● the active channel and drive port (P1, P2 ...)
● the statistics for the sweep average (if sweep average is on, otherwise "Avg None")
● the progress of the sweep

The progress bar also shows when the R&S ZNB/ZNBT prepares a sweep with
new channel settings

● the External Reference symbol (if an external reference clock is used for synchroni-
zation)

● the Redefined S-parameters symbol (if the physical ports have been redefined)
● the LXI status symbol (if enabled; see "SYSTEM > SETUP > Remote Settings")

A green LXI status symbol indicates that a LAN connection has been established;
a red symbol indicates that no LAN cable is connected.

● the switch matrix status symbol, if a switch matrix is connected to the analyzer
(See the R&S ZNB/ZNBT User Manual)

● the current date and time

 

Control Elements of the Screen



Operating the InstrumentR&S® ZNB/ZNBT

46Getting Started 1316.0062.02 ─ 20

Figure 4-1: R&S ZNB/ZNBT with redefined physical ports

Figure 4-2: R&S ZNB/ZNBT with switch matrix

The progress bar slowly oscillates from left to right and back if the sweep is too fast to
be monitored, e.g. because the number of sweep points is low. You can hide the status
bar using "SYSTEM > DISPLAY > View Bar".

4.3 Working with Dialogs

Dialogs provide groups of related settings and allow to make selections and enter data
in an organized way. The settings are visualized, if possible. An example is shown
below.

All dialogs are operated in a similar way.
● To open a dialog, select a softtool button with three dots behind its labeling (e.g.

"Start Cal (Manual) ...").
● Use the "Transparency" function to obtain a transparent dialog which you can con-

trol while viewing the underlying traces and display elements.
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● Drag and drop the hatched triangle in the lower right corner of the dialog to modify
its size.

● Some dialogs are subdivided into tabs, containing groups of related settings. Acti-
vate a tab to access the settings.

● Select "OK" to activate the current settings and close the dialog, "Cancel" to dis-
card all changes.

The Help system provides useful information about each dialog's specific settings. Tap
"Help" to open the Help.

4.4 Handling Diagrams, Traces, and Markers

The analyzer displays measurement results as traces in rectangular diagrams. Markers
are used to read specific numerical values and to search for points or regions on a
trace. The following section will make you familiar with some of the graphical tools the
R&S ZNB/ZNBT provides for trace and marker handling.

For further reference
Refer to chapter "Concepts and Features" in the R&S ZNB/ZNBT Help or in the User
Manual to learn more about traces, channels, and screen elements.

4.4.1 Adding New Traces and Diagrams

A new trace is needed if you want to measure and display an additional quantity.

Typical scenario: The transmission coefficient S21 is measured as described in Chap-
ter 5.1, "Transmission S-Parameter Measurement", on page 59. A trace is added to
display the reflection coefficient S11 for comparison.

To create a new trace,

1. Drag the "New Trace" icon from the toolbar above the diagram area into a diagram.

The diagram changes its color scheme and contents as shown below. A rectangle
with diagonal lines divides the diagram into different sectors.
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2. Select the sector, depending on whether you want to display the new trace in the
existing diagram, or whether you want to add a new diagram.

3. In the dialog box that is opened when you release the "New Trace" icon, select an
S-parameter to display.
For a four-port analyzer:

The R&S ZNB/ZNBT generates a new trace for the selected S-parameter.

Alternative control elements
The "TRACE > Trace Config" softtool tab provides more functions for trace handling.
The "DISPLAY > Display > Diagram" softtool tab provides functions for efficient dia-
gram handling.
To add a trace for an arbitrary measured quantity (e.g. a ratio, wave, impedance, or
admittance parameter), you can open the tabs of the "TRACE > Meas" softtool and
simply drag and drop the corresponding softkeys into a diagram area.

4.4.2 Adding New Markers

A marker is needed e.g. if you want to read a particular numerical trace value.
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To add a new marker,
● Drag and drop the "New Marker" icon in the toolbar above the diagram area to the

desired position.
The marker appears on the active trace. The marker info field displays the stimulus
value (x-axis value) and response value (y-axis value) at the marker position. The
response value varies as the analyzer continues performing sweeps.

Alternatively, any marker offered in "TRACE > Marker > Markers" softtool tab can
be positioned on the active trace by Drag&Drop.

Active trace, alternative control elements
The trace line of the active trace in the upper part of the diagram is highlighted. If the
diagram contains several traces, first activate the the target trace, then add the marker.
The "TRACE > Marker > Markers" softtool tab provides more functions for marker han-
dling.

4.4.3 Deleting Display Elements

Markers, traces, diagram areas, and other display elements are most conveniently
deleted using the "Delete" icon in the toolbar above the diagram area.
● To delete a single marker, drag it into vertical direction to release it from the trace

and drop it onto the "Delete" icon.
To delete a set of markers, drag and drop their marker info field onto the "Delete"
icon. You can delete all types of marker info fields, including e.g. the info fields for
a band-filter search.
Deleting a marker and its info field also disables the associated marker function.

● To delete a trace, drag and drop its trace line onto the "Delete" icon.
● To delete a channel, drag and drop all associated traces onto the "Delete" icon.
● To hide the limit lines and disable the limit check, drag and drop the PASS / FAIL

message onto the "Delete" icon. The limit line itself is not deleted; you can re-use it
any time.

● To delete a diagram area, drag and drop the diagram number label in the upper
right corner onto the "Delete" icon.
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The context menu of some display elements (e.g. markers) also provides the "Delete"
function.

Undo function
If you happen to delete a display element unintentionally, you can simply restore it
using the UNDO key or the "Undo" icon in the toolbar.

4.4.4 Using Drag and Drop

You can drag and drop many of the R&S ZNB/ZNBT's control and display elements in
order to change their size and position. The drag and drop functionality is often more
convenient to use than the equivalent buttons of the softtool panels. The following table
gives an overview.

Table 4-1: Drag and drop functionality for various screen elements

Screen element Action Drag and drop...

Diagram Create "New Trace" icon --> existing diagram; see Chapter 4.4.1, "Adding New Traces
and Diagrams", on page 47

 Re-size Frame (shaded bar in-between adjacent diagrams)

 Delete Diagram number label ---> "Delete" icon; see Chapter 4.4.3, "Deleting Display
Elements", on page 49

Trace Create "New Trace" or "New Ch + Tr" icon --> existing diagram; see Chapter 4.4.1, "Add-
ing New Traces and Diagrams", on page 47

 Move vertically Reference line marker (right diagram edge)

 Move into other or new
diagram

Trace line

 Delete Trace line --> "Delete" icon; see Chapter 4.4.3, "Deleting Display Elements",
on page 49

 Reset / suspend
graphic zoom

"Graphic Zoom" element in additional trace line --> "Delete" icon; see Chap-
ter 4.6.1, "Using the Graphic Zoom", on page 54

Marker Create "New Marker" icon --> existing diagram; see Chapter 4.4.2, "Adding New Mark-
ers", on page 48

 Move horizontally Marker symbol

 Delete Marker or marker info field --> "Delete" icon; see Chapter 4.4.3, "Deleting Display
Elements", on page 49

Marker info field Add / delete See marker above (the info field is always tied to a marker)

 Move within diagram Marker info field (move to one of several pre-defined positions)

Softtool area Move Softtool area (move to the right or left edge of the screen)
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4.5 Entering Data

The analyzer provides dialogs with various types of input fields where you can enter
numeric values and character data. Data entry with a mouse and an external keyboard
is a standard procedure known from other Windows® applications. However, there are
various other ways to enter data.

4.5.1 Using Front Panel Keys

On a R&S ZNB you can use the keys in the DATA ENTRY keypad to enter numbers,
units, and characters.

To enter a numeric value

1. Select a numeric data input field to activate it.

2. Press the DATA ENTRY keys.

● Use "0" to "9" to enter the corresponding numbers.
● Use "." and "-" to enter a decimal point or change the sign of the value.
● Use "G/n", "M/μ", "k/m", or "x1" to multiply the entered value with factors of

10(-)9, 10(-)6, 10(-)3 or 1 and add the appropriate physical unit.

To enter a character string

1. Tap a character data input field to activate it.

2. Press the DATA ENTRY keys as if you were writing a short message on your
mobile phone.

● Press "0" to "9" once to enter the corresponding numbers.
● Use "." or "-" to enter a dot or a hyphen.
● Use "G/n", "M/μ", or "k/m" to enter the letters G, M or K (case-insensitive).
● Use the BACKSPACE key to correct wrong entries, deleting the character to

the left of the current cursor position.
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● Press ENTER to complete an entry.
● Press ESC CANCEL to discard the entries made.

3. To enter letters other than G, M or K, you can also use one of the methods descri-
bed in the following sections:

● Chapter 4.5.3, "Using the Analyzer's On-Screen Keyboard", on page 53
● Chapter 4.5.4, "Using the Windows® On-Screen Keyboard", on page 53

4.5.2 Using the Numeric Editor

The "Numeric Editor" is a tool for convenient entry and modification of numeric values.
It is available for all numeric input fields in the "Vector Network Analyzer" (VNA) appli-
cation.

Operation with touchscreen or mouse:

1. Double-tap or double-click a numeric input field in a dialog or softtool panel to open
the numeric editor.

2. Use the buttons in the numeric keypad to compose the numeric input value.

3. If desired, select a "Stepsize" and use the cursor up/down buttons to increment/
decrement the current value. If a marker is active, you can also set the numeric
value to the current marker value ("Set to Marker").

4. After completing the input string select "Enter" to apply your selection and close the
numeric editor.
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STEP SIZE key
If a numeric input field is active, the STEP SIZE front panel key to the right of the rotary
knob opens a dialog box containing the "Step Size" panel of the numeric editor. Use
this box for efficient operation of the rotary knob.

4.5.3 Using the Analyzer's On-Screen Keyboard

The on-screen "Keyboard" allows you to enter characters, in particular letters, without
an external keyboard. It is available for all character input fields in the "Vector Network
Analyzer" (VNA) application.

Operation with touchscreen:

1. Double-tap to activate a character data input field in a dialog or in a softtool panel
and open the on-screen keyboard.

2. Tap the buttons to select the characters for the input string.

3. After completing the input string tap "Enter" to apply your selection and close the
keyboard.

Operation with a mouse:

1. Double-click a character data input field to open the on-screen keyboard.

2. Click a sequence of characters and "Enter" to apply your selection and close the
keyboard.

4.5.4 Using the Windows® On-Screen Keyboard

The Windows® on-screen keyboard allows you to enter characters, in particular letters,
even if an input field cannot call up the analyzer's own on-screen keyboard. Examples
are input fields in standard Windows ® dialogs.
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To call up the on-screen keyboard,

1. Use the "SYSTEM > APPLIC" key to open the "Applic" softtool.

2. In the "External Tools" tab select "Screen Keyboard".

4.6 Scaling Diagrams

The analyzer provides many alternative tools for customizing the diagrams and for set-
ting the sweep range. Choose the method that is most convenient for you.

4.6.1 Using the Graphic Zoom

The graphic zoom function magnifies a rectangular portion of the diagram (zoom win-
dow) to fill the entire diagram area. The sweep points are not affected.

To activate the graphic zoom,
● Activate the "Zoom Select" toggle button in the toolbar above the diagram area.

The icon changes its color as shown on the left side.
● In the active diagram area, select an appropriate rectangular area.

The zoomed view shows the selected area, scaled in both horizontal and vertical
direction. In general, the zoom window covers only part of the sweep range; the
distance between the displayed sweep points increases. The reduced sweep range
is displayed in the additional trace lines at the bottom of the diagram.
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If you activate the "Overview Select" toggle button and then proceed as described for
"Zoom Select", the upper part of the diagram shows a small version of the original dia-
gram for comparison. You can move the zoomed part of the trace by moving the
selected rectangular area in the overview.

Use the "Zoom Reset" icon to restore the original diagram. Alternatively, you can drag
and drop the "Zoom" label in the additional channel line onto the "Delete" button.

Alternative settings
The "TRACE > Scale > Zoom" softtool panel provides numeric input fields where you
can refine the displayed zoom range. To zoom the stimulus range and change the
sweep point spacing so that the number of displayed sweep points is maintained, use
"STIMULUS > Stimulus > Zoom Stimulus".

4.6.2 Setting the Sweep Range

The sweep range for all channels is displayed in the channel list across the bottom of
the diagram:

To change the sweep range, use one of the following methods:
● Press either the START and STOP keys or the CENTER and SPAN keys in the

STIMULUS keypad.
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● Tap and hold (with a mouse: right-click) the start or stop value in the channel list for
some seconds and select "Start Frequency", "Stop Frequency", "Center Fre-
quency", "Frequency Span" from the context menu.

● Select "Start Frequency", "Stop Frequency", "Center Frequency", "Span Fre-
quency" from the "Channel > Stimulus" menu.

● Use the "Set by Marker" functions ("TRACE > MARKER > Set by Marker"; see
Chapter 4.6.6, "Set by Marker", on page 57).

4.6.3 Reference Value and Position

The analyzer provides three parameters for changing the scale of the vertical
(response) axis:
● Changing the "Ref Value" or "Ref Position" shifts the trace in vertical direction and

adjusts the labels of the vertical axis. "Ref Value" also works for radial diagrams.
● Changing the "Scale/Div" modifies the value of the vertical or radial diagram divi-

sions and thus the entire range of response values displayed.

The "Scale/Div" and the "Ref Value" are indicated in the scale section of the trace list.
In the example below, a "Scale/Div" of 10 dB and a "Ref Value" of 0 dB is used.

To change one of the parameters use one of the following methods:
● Select "TRACE > SCALE > Scale Values" to access the settings in the softtool tab.
● Tap and hold (with a mouse: right-click) the scale section in the trace list for some

seconds and select the settings from the context menu.
● Select the settings from the "Trace > Scale > Scale Values" menu.
● Use the "Set by Marker" functions ("TRACE > MARKER > Marker Funct"; see

Chapter 4.6.6, "Set by Marker", on page 57).

4.6.4 Auto Scale

The "Auto Scale" function adjusts the scale divisions and the reference value so that
the entire trace fits into the diagram. To access "Auto Scale", use one of the following
methods:
● Select "TRACE > SCALE > Scale Values" to access the "Auto Scale..." settings in

the softtool tab.
● Tap and hold (with a mouse: right-click) the scale section in the trace list and select

"Auto Scale Trace" from the context menu.
● Select "Auto Scale..." from the "Trace > Scale > Scale Values" menu.
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4.6.5 Circular Diagrams

The radial scale of a circular ("Polar", "Smith" or "Inverted Smith") diagram can be
changed with a single linear parameter, the "Ref Value". The reference value defines
the radius of the outer circumference.
● Increasing the "Ref Value" scales down the polar diagram.
● Decreasing the "Ref Value" magnifies the polar diagram.

The "Ref Value" is indicated in the scale section of the trace list.

To change the "Ref Value" use one of the following methods:
● Select "TRACE > SCALE > Scale Values" to access the parameter in the softtool

tab.
● Tap and hold (with a mouse: right-click) the scale section in the trace list and select

the parameter from the context menu.
Tap and hold the scale section in the trace list for some seconds (with a mouse:
right-click) and select "Ref Value..." from the context menu.

● Select the parameter from the "Trace > Scale > Scale Values" menu.
● Use the "Set by Marker" functions; see Chapter 4.6.6, "Set by Marker",

on page 57.

4.6.6 Set by Marker

The "Set by Marker" functions are a convenient tool for scaling (in particular: magnify-
ing) diagrams without entering explicit numeric values. You simply place a marker to a
trace point and use the marker values to change the sweep range or move the trace
relative to the vertical axis. The touchscreen or a mouse makes it easier to activate
(touch/click) or move (drag and drop) markers.

To set the sweep range use one of the following methods.
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Define "Start" and "Stop" values:

1. Create two normal markers, e.g. the markers Mkr 1 (M1) and Mkr 2 (M2), and
place them to the desired start and stop values of the sweep range.

2. Activate "M1" and tap "TRACE > MARKER > Set by Marker > Start = Marker".

3. Activate "M2" and tap "TRACE > MARKER > Set by Marker > Stop = Marker".

Use a definite "Span:"

1. Create a marker and set it to delta mode.
The analyzer automatically creates a reference marker in addition to the delta
marker.

2. Place the reference marker to the desired start value of the sweep range.

3. Set the value of the delta marker equal to the desired (positive or negative) span.

4. Activate the delta marker and tap "TRACE > MARKER > Set by Marker > Span =
Marker".

To move the trace relative to the vertical axis proceed as follows:

1. Create a normal marker, e.g. the marker Mkr 1 (M1), and place it to a particular
trace point. E.g. you can use the "Marker Search" functions to locate a maximum or
minimum on the trace.

2. Select "TRACE > MARKER > Set by Marker > Max = Marker" to move the trace
towards the upper diagram edge, leaving the values of the vertical divisions
("Scale/Div") and the overall vertical scale unchanged. Analogously, select "Min =
Marker" to move the trace towards the lower diagram edge, or select "Ref Val =
Marker" to move the trace towards the "Ref Value".

You can also use marker values in the "Numeric Editor" dialog; see Chapter 4.5.2,
"Using the Numeric Editor", on page 52.

4.6.7 Enlarging a Diagram

The analyzer provides different tools for customizing the contents and size of the dia-
grams:
● Double-Tapping (or double-clicking) a diagram maximizes the diagram to occupy

the whole diagram area.
● The "Menu Bar", "Status Bar", "Hard Key Panel", and the "Title Bar" are optional

display elements which you can hide in order to gain space for the diagrams
("SYSTEM > DISPLAY > View Bar").

● "SYSTEM > DISPLAY > Config" softtool tab provides optional display elements for
the interior of the diagrams.

Use the context menu of the diagram, the SYSTEM > DISPLAY key or the "Display"
menu to access the display settings.
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5 Performing Measurements
The following chapter describes a sample session with a R&S ZNB/ZNBT network ana-
lyzer and explains how to solve basic tasks that you will frequently encounter when
working with the instrument.

Safety considerations
Before starting any measurement on your network analyzer, please note the instruc-
tions given in Chapter 2, "Putting the Analyzer into Operation", on page 8.

Use the "S-Parameter Wizard" accessible via "TRACE > MEAS > S-Params > S-
Param Wizard ..." to perform a standard S-parameter measurement in a straightfor-
ward way. The wizard provides a series of dialogs where you can select the test setup,
screen configuration and measurement parameters, configure the essential channel
settings and perform a guided calibration.

Measurement stages in the wizard

The individual dialogs of the "S-parameter Wizard" correspond to the typical stages of
any measurement:

1. Select the test setup

2. Define port impedances

3. Select the measurement parameters and the diagrams

4. Define the sweep range

5. Adjust the receiver and source settings (measurement bandwidth, source power)

6. Perform a calibration

5.1 Transmission S-Parameter Measurement

In a transmission measurement, the analyzer transmits a stimulus signal to the input
port of the device under test (DUT) and measures the transmitted wave at the DUT's
output port. The trace settings allow you to select the measured quantities and display
formats, depending on what you want to learn from the data. A minimum of two ana-
lyzer test ports are required for transmission measurements.

In the following example, the analyzer is set up for a two-port transmission measure-
ment. A frequency sweep range is selected, the instrument is calibrated and the mea-
surement result is analyzed using various display formats.
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5.1.1 Connecting the Instrument for Transmission Measurements

In order to prepare a transmission measurement, you have to connect your DUT
(which for simplicity we assume to have appropriate connectors) in-between a pair of
analyzer test ports. It is recommended that you preset the R&S ZNB/ZNBT in order to
start from a well-defined instrument state.

1. Connect the DUT between test ports 1 and 2 of the network analyzer as shown
above.

2. Proceed as described in Chapter 2.7, "Starting the Analyzer and Shutting Down",
on page 11, to switch on the instrument and start the VNA application.

3. Use the SYSTEM > PRESET key to perform a factory preset of the analyzer.
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The analyzer is now set to its default state. The default measured quantity is the
transmission S-parameter S21.

Select TRACE > TRACE CONFIG and use the control elements in the "Traces" softtool
panel if you wish to create a new trace or a new diagram.

5.1.2 Selecting the Sweep Range and Other Parameters

After a system preset the display shows a diagram with a dB magnitude scale, and the
S-parameter S21 is selected as a measured quantity. This S-parameter is the forward
transmission coefficient of the DUT, defined as the ratio of the transmitted wave at the
DUT's output port (port no. 2) to the incident wave at the DUT's input port (port no. 1).

The R&S ZNB/ZNBT automatically adjusts its internal source and receiver to the
selected measured quantities: For an S21 measurement, a stimulus signal (termed a1)
is transmitted at the analyzer port no. 1; the transmitted wave (termed b2) is measured
at port 2. The stimulus signal from the analyzer port no. 2 is not needed except for
some calibration types.

The default sweep range is from 100 kHz to the maximum frequency of the analyzer,
except for the R&S ZNB40, which starts at 10 MHz. To gain some more insight into the
transmission characteristics of your DUT you can select a smaller sweep range.

1. Select STIMULUS > START and, in the "Start Frequency" input field of the opened
softtool panel, enter the lowest frequency you want to measure (e.g. 1.77 GHz).
For convenient numeric entry, open the "Numeric Editor" dialog (see Chapter 4.5.2,
"Using the Numeric Editor", on page 52).

Tip: If you use the DATA ENTRY keys at the front panel for data entry (R&S ZNB
only), simply type 1.77 and terminate the entry with the G/n key.
Refer to Chapter 4.5, "Entering Data", on page 51 to learn more about entering
numeric values and characters.

2. In the "Stop Frequency" input field enter the highest frequency you want to mea-
sure (e.g. 2.5 GHz).

3. Select "TRACE > SCALE > Scale Values" and activate the "Auto Scale Trace"
function. The analyzer adjusts the scale of the diagram to fit in the entire S21 trace,
leaving an appropriate display margin.
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Tip: Refer to Chapter 4.6, "Scaling Diagrams", on page 54 to learn more about the
different methods and tools for diagram scaling.

5.1.3 Calibrating the Instrument

Calibration (system error correction) is the process of eliminating systematic, reprodu-
cible errors from the measurement results. E.g. in the current test setup, the connect-
ing cables between the analyzer ports and the DUT introduce an attenuation of the
waves on their way from the analyzer port 1 to the input of the DUT and from the DUT
output to the analyzer port 2. The length of the cables also introduces a phase shift of
the waves. Both effects impair the accuracy of the S-parameter measurement.

The analyzer provides a wide range of sophisticated calibration methods for all types of
measurements. Which calibration method should be selected depends on the expected
system errors, the accuracy requirements of the measurement, on the test setup and
on the types of calibration standards available.

The following example requires a calibration kit with a male Through standard with
known transmission characteristics for the related test port connector type and gender.
With a single Through, it is possible to perform a transmission normalization, compen-
sating for a frequency-dependent attenuation and phase shift in the signal paths.

Due to the R&S ZNB/ZNBT's calibration wizard, calibration is a straightforward, menu-
guided process.

1. Replace the DUT by the Through standard of your calibration kit.

2. Select "CHANNEL > CAL > Start Cal (Manual)" to open the "Calibration Presetting"
dialog.

3. Select the port combination Port 1 (P1) and Port 2 (P2) and the calibration type
"Trans Norm". Ensure that port 1 is defined as the source port.
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Tip: For a R&S ZNBT with more than 4 ports the graphical port representation is
replaced by a generic port list. The selection logic is unchanged.

4. Select "Next" to proceed to the next page of the "Calibration Presetting" wizard.

5. Select the test port connector type and gender (here: N 50 Ω, Female, correspond-
ing to a male Through standard) and the calibration kit (here: "ZV-Z121"), then click
"Start".

Transmission S-Parameter Measurement



Performing MeasurementsR&S® ZNB/ZNBT

64Getting Started 1316.0062.02 ─ 20

6. The "Calibration" dock widget indicates the calibration standards to be measured.
Select "Through (mm)" to initiate the measurement of the connected Through stan-
dard.
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The analyzer performs a calibration sweep for the measured quantity S21. The
magnitude and phase of the result is displayed in two diagrams, together with the
expected typical result for a through standard (red traces, hidden by the blue ones
in our example). The similarity of the red and the blue traces indicates that the
Through standard has been properly connected. After the R&S ZNB/ZNBT has
completed the calibration sweep and calculated the correction data, the "Apply"
button is available.

7. Select "Apply" to close the wizard and apply the system error correction to the cur-
rent channel. A "Cal" label appears in the trace list.

8. Remove the Through standard and connect the DUT again.

5.1.4 Evaluating Data

The analyzer provides various tools to optimize the display and analyze the measure-
ment data. For instance, you can use markers to determine maxima and minima on the
trace, and change the display format to obtain information about the group delay of the
transmitted wave.

1. Select "TRACE > MARKER > Mkr 1". This places "Marker 1" to its default position
(center of the sweep range).
A marker symbol (triangle) appears on the trace. The stimulus value (frequency)
and response value (magnitude of the transmission coefficient converted to a dB
value) at the marker position is displayed in the marker info field in the upper right
corner of the diagram.

2. Select the "Marker Search" softtool tab and activate "Min" search.
The marker jumps to the absolute minimum of the curve in the entire sweep range.
The marker info field shows the coordinates of the new marker position.

3. Select "TRACE > FORMAT" and choose the "Delay" of the transmission coefficient
as displayed quantity.

The group delay represents the propagation time of the wave through the DUT; it is
displayed in a Cartesian diagram. The marker info field shows the frequency and
group delay at the marker position.
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Refer to section "Display Formats and Diagram Types" in the help system or in the
user manual to learn more about the diagram properties.

5.1.5 Saving and Printing Data

The analyzer provides standard functions for saving measurement settings and for
saving or printing the results. You can use these functions as if you were working on a
standard PC. Moreover you can export your trace data to an ASCII file and reuse it in a
later session or in an external application.

Data transfer is made easier if external accessories are connected to the analyzer or if
the instrument is integrated into a LAN. Refer to Chapter 2.9, "Connecting External
Accessories", on page 12, and Chapter 2.12, "Remote Operation in a LAN",
on page 16 to obtain information about the necessary steps.

1. Select "SYSTEM > FILE" to open the "File" softtool.

2. In the "Trace Data" tab of the "File" softtool select "Export > ASCII" to open the
"Export Data - ASCII Files" dialog

3. In the "Export Data - ASCII Files" dialog, select a file location ("Look in:"), enter a
file name and select "Save".
The active trace data is written to an ASCII file and the dialog closes.

4. In the "Print" tab of the "File" softtool select "Print" to create a hardcopy of your dia-
gram or "To Clipboard" to copy the diagram to the Windows clipboard

5. Select "SYSTEM > FILE > Recall Sets > Save..." to open the "Save" dialog for
recall sets.

6. In the "Save" dialog, select a file location ("Look in:"), enter a name for the recall
set file and select "Save".
The active recall set containing your instrument settings is stored to a file and can
be used again in a later session.

Proceed as described in Chapter 2.7, "Starting the Analyzer and Shutting Down",
on page 11 to shut down your analyzer.

 

Transmission S-Parameter Measurement
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5.2 Reflection S-Parameter Measurement

In a reflection measurement, the analyzer transmits a stimulus signal to the input port
of the device under test (DUT) and measures the reflected wave. A number of trace
formats allow you to express and display the results, depending on what you want to
learn from the data. Only one analyzer test port is required for reflection measure-
ments.

In principle a reflection measurement involves the same steps as a transmission mea-
surement. Note the following differences:
● The basic test setup for reflection measurements involves a single DUT and ana-

lyzer port. For instance, you can connect the input of your DUT to port 1 of the ana-
lyzer as shown below.

 

Reflection S-Parameter Measurement
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You can also use the basic transmission test setup, e.g. if you want to measure
reflection and transmission parameters in parallel.

● The analyzer provides special calibration types for reflection measurements. Use
the calibration wizard and select an appropriate type. The full n-port calibration
types (TOSM, UOSM, TNA ...) will correct the system errors for all transmission
and reflection S-parameters.

● Some of the trace formats are particularly suited for reflection measurements. E.g.
you can display the measured reflection coefficient S11 in a Smith chart in order to
obtain the complex input impedance at port no. 1.

Reflection S-Parameter Measurement
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6 Administrative Tasks
This chapter describes various topics which you may need only occasionally or in case
that you desire a special instrument configuration.

6.1 Windows Operating System

The analyzer is equipped with a Windows® 7 operating system which has been config-
ured according to the instrument's features and needs. Changes in the system configu-
ration can be necessary in order to:
● Establish a LAN connection
● Customize the properties of the external accessories connected to the analyzer
● Call up additional software tools

Modifications of the operating system
The operating system is adapted to the network analyzer. To avoid impairment of
instrument functions, only change the settings described in this manual. Existing soft-
ware must be modified only with update software released by Rohde & Schwarz. Like-
wise, only programs authorized by Rohde & Schwarz for use on the instrument must
be executed.

The "Start" menu of the operating system is accessed by pressing the Windows key in
the SYSTEM keypad or on an external keyboard. All necessary settings can be
accessed from the "Start" menu, in particular from the "Control Panel".

User accounts and password protection
The analyzer uses a user name and password as credentials for remote access. Two
user accounts with different levels of access are available on the instrument:
● "instrument" is the default account with standard rights to change system settings.

Use this account for normal operation of the analyzer.
● "Administrator" is the account for administering the operating system. This account

is required e.g. if you wish to install programs on the analyzer.

In the factory configuration, "894129" is preset as a password for both users. To pro-
tect the analyzer from unauthorized access, it is recommended to change the factory
setting ("Control Panel > User Accounts > Change your password").

To switch from one user account to the other, use Windows ""Logoff" and "Logon". On
the R&S ZNB/ZNBT the "Switch User" functionality is disabled.

 

 

Windows Operating System
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6.2 Firmware Update

Upgrade versions of the analyzer firmware are supplied as single setup files *.msi.

Administrator account
You need administrator rights to install a new firmware version. See note on "User
accounts and password protection" on page 69 for details.

To perform a firmware update,

1. Copy the setup file to any storage medium accessible from the analyzer. This may
be the internal hard disk, an external storage medium (USB memory stick, external
CD-ROM drive) or a network connection (LAN, GPIB bus).

2. In the Windows® Explorer, tap the setup file twice (or double-click with a mouse)
and follow the instructions of the setup wizard.

Setup files can be stored and installed again. The default drive name of the internal
hard disk is C:. External storage devices are automatically mapped to the next free
drive, i.e. D:, E: etc.

Factory calibration
A firmware update does not affect the factory calibration.

External accessories
Calibration units must be disconnected during a firmware update.

 

Firmware Update
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7 Maintenance
The R&S ZNB/ZNBT vector network analyzer does not require any special mainte-
nance.

For our support center address and a list of useful R&S contact addresses refer to the
documentation CD-ROM or the "Contact" page at the beginning of the Help system.

7.1 Storing and Packing the Instrument

The vector network analyzer can be stored at the temperature range quoted in the data
sheet. When it is stored for a longer period of time the unit should be protected against
dust.

The original packing should be used when the unit is to be transported or dispatched;
please also observe the notes in Chapter 2.1, "Unpacking and Checking the Instru-
ment", on page 8.

7.2 Replacing Fuses

The R&S ZNBT is protected by a time lag fuse (T15L250V, stock no. 3589.7478.00).
The fuse is screwed in below the AC power switch on the rear panel.

For the R&S ZNB the optional "Bias Tee" inputs at the rear panel (labeled PORT BIAS
<no>) are each protected by a fuse (0.250 A, F IEC60127-2/2, stock no.
0020.7246.00).

Shock hazard
Before replacing a fuse, make sure that the instrument is switched off and disconnec-
ted from all power supplies.
Always use fuses supplied by Rohde & Schwarz as spare parts, or fuses of the same
type and rating.

To replace the mains fuse (R&S ZNBT only)

1. Unscrew the fuse holder from the rear panel and pull the fuse holder out of the slot.

2. Pull the fuse out of the fuse holder and replace it by a new one.

3. Stick the fuse holder back into the slot in the rear panel and screw it tight.

To replace the DC input fuses

► Open the fuse holder by slightly turning the lid counterclockwise.

 

 

 

Replacing Fuses
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8 Obtaining Technical Support
The instrument generates error messages which in most cases will be sufficient for you
to detect the cause of an error and find a remedy. Error message types are described
in the R&S ZNB/ZNBT User Manual; refer to section "Error Messages and Trouble-
shooting".

In addition, our customer support centers are there to assist you in solving any prob-
lems that you may encounter with your network analyzer. We will find solutions more
quickly and efficiently if you provide us with the information listed below. Simply open
the relevant dialogs in the "Info" dialog, select "Save...", and send us the file.
● Setup Info: The instrument setup information ("Info > Setup Info") contains your

instrument settings. You can also send us the VNA recall set file (*.znx) that you
generate after the fault occurs ("File > Recall Sets > Save...").

● Option Info: The option info ("Info > Option Info") informs us about the status of all
software and hardware options of your analyzer.

● Hardware Info: The hardware info ("Info > Hardware Info") shows us the installed
options and hardware assemblies.

● Error Log: The error log ("Info > Error Log") contains a chronological record of
errors.

● Exception Dumps: In case of an exception the R&S ZNB/ZNBT automatically
generates a dump file for debugging purposes.
The level of detail of the dumps can be set from the "Advanced" tab of the "System
Config" dialog.
The latest 5 exception dumps can be retrieved using the "Save Report" function of
the "Info" dialog.

● Save Report: The system report command ("Info > Save Report") collects the
setup, option, and hardware information as well as the error log and the current
selftest results and writes everything to a *.zip file. The *.zip file also contains the
current eeprom data and a screenshot of the VNA display. It is written to the report
directory C:\Users\Public\Documents\Vna\Report. The file name contains
the current date and time, e.g. report_20110125_1658.zip. "Save Report"
provides the most comprehensive information, comprising all other "Info" files.
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